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Preface

How to Use This Guide

Purpose of This
Guide

The Applied Biosystems 3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, 
and Reference Guide provides instructions for maintaining the Applied Biosystems 
3130/3130xl Genetic Analyzers. It includes how to troubleshoot hardware, software, and 
chemistry issues. This manual also includes reference information.

Audience This manual is written for principle investigators and laboratory staff who are planning 
to operate and maintain the Applied Biosystems 3130/3130xl Genetic Analyzers.

Assumptions This guide assumes the following background:

• Familiarity with Microsoft® Windows® XP operating system. 

• Knowledge of general techniques for handling DNA samples and preparing them 
for electrophoresis. 

• A general understanding of hard drives and data storage, file transfers, and copying 
and pasting.

If you want to integrate the 3130/3130xl genetic analyzers into your existing laboratory 
data flow system, you need networking experience.

Text Conventions This guide uses the following conventions: 

• Bold indicates user action. For example:

Type 0, then press Enter for each of the remaining fields.

• Italic text indicates new or important words and is also used for emphasis. For 
example:

Before analyzing, always prepare fresh matrix.

• A right arrow bracket (>) separates successive commands you select from a drop-
down or shortcut menu. For example:

Select File > Open > Spot Set.
Right-click the sample row, then select View Filter > View All Runs.

User Attention
Words

Two user attention words appear in Applied Biosystems user documentation. Each word 
implies a particular level of observation or action as described below:

• Note – Provides information that may be of interest or help but is not critical to the 
use of the product.

• IMPORTANT! – Provides information that is necessary for proper instrument 
operation, accurate chemistry kit use, or safe use of a chemical.
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How to Obtain More Information

Related
Documentation

The following related document is shipped with the system:

• Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide 
(P/N 4352715) - Contains procedures and information to start a run using the 
instrument system.

• Applied Biosystems 3130/3130xl Genetic Analyzers Site Preparation Guide 
(P/N 4352717) - Contains the space, environmental, and electrical requirements to 
support the 3130/3130xl Genetic Analyzer system.

• Applied Biosystems 3730/3730xl DNA Analyzers and Applied Biosystems 
3130/3130xl Genetic Analyzers AB Navigator Software Administrator Guide 
(P/N 4359472) - Provides information and procedures for the administrator 
maintaining the computer system and software files of the Applied Biosystems 
3130/3130xl Genetic Analyzers.

• Applied Biosystems 3130/3130xl Genetic Analyzers Quick Reference Card 
(P/N 4362825) - Contains a flowchart on how to run your samples and instrument, a 
table of maintenance tasks, and a Data Collection software reference guide.

Send Us Your
Comments

Applied Biosystems welcomes your comments and suggestions for improving its user 
documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

How to Obtain Support
For the latest services and support information for all locations, go to 
http://www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:

• Search through frequently asked questions (FAQs)

• Submit a question directly to Technical Support

• Order Applied Biosystems user documents, MSDSs, certificates of analysis, and 
other related documents

• Download PDF documents

• Obtain information about customer training

• Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers 
to contact Applied Biosystems Technical Support and Sales facilities.

mailto:techpubs@appliedbiosystems.com
http://www.appliedbiosystems.com
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Safety

This section covers the following topics:

Safety Conventions Used in This Document  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .viii

Symbols on Instruments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  ix

Safety Labels on Instruments  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . x

General Instrument Safety  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xi

Chemical Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xii

Chemical Waste Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xiii

Electrical Safety  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xiv

Laser Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xv

Workstation Safety  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .xvi

Safety and Electromagnetic Compatibility (EMC) Standards  . . . . . . . . . . . . . . . . . . xvii
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Safety Conventions Used in This Document

Safety Alert
Words

Four safety alert words appear in Applied Biosystems user documentation at points in 
the document where you need to be aware of relevant hazards. Each alert 
word–IMPORTANT, CAUTION, WARNING, DANGER–implies a particular level of 
observation or action, as defined below:

Definitions

IMPORTANT! – Indicates information that is necessary for proper instrument operation, 
accurate chemistry kit use, or safe use of a chemical.

 – Indicates a potentially hazardous situation that, if not avoided, may 
result in minor or moderate injury. It may also be used to alert against unsafe practices.

 – Indicates a potentially hazardous situation that, if not avoided, 
could result in death or serious injury.

 – Indicates an imminently hazardous situation that, if not avoided, 
will result in death or serious injury. This signal word is to be limited to the most extreme 
situations.

Except for IMPORTANTs, each safety alert word in an Applied Biosystems document 
appears with an open triangle figure that contains a hazard symbol. These hazard 
symbols are identical to the hazard icons that are affixed to Applied Biosystems 
instruments (see “Safety Symbols” on page x).
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Examples

The following examples show the use of safety alert words:

IMPORTANT! You must create a separate Sample Entry Spreadsheet for each 96-well 
microtiter plate.

The lamp is extremely hot. Do not touch the lamp until it has cooled 
to room temperature.

CHEMICAL HAZARD. Formamide. Exposure causes eye, skin, 
and respiratory tract irritation. It is a possible developmental and birth defect hazard. 
Read the MSDS, and follow the handling instructions. Wear appropriate protective 
eyewear, clothing, and gloves.

ELECTRICAL HAZARD. Failure to ground the instrument 
properly can lead to an electrical shock. Ground the instrument according to the provided 
instructions.

Symbols on Instruments

Electrical
Symbols on
Instruments

The following table describes the electrical symbols that may be displayed on 
Applied Biosystems instruments.

Symbol Description

Indicates the On position of the main power switch.

Indicates the Off position of the main power switch.

Indicates the On/Off position of a push-push main power switch.

Indicates a terminal that may be connected to the signal ground reference of 
another instrument. This is not a protected ground terminal.

Indicates a protective grounding terminal that must be connected to earth 
ground before any other electrical connections are made to the instrument.

Indicates a terminal that can receive or supply alternating current or voltage.

Indicates a terminal that can receive or supply alternating or direct current or 
voltage.
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Safety Symbols The following table describes the safety symbols that may be displayed on 
Applied Biosystems instruments. Each symbol may appear by itself or in combination 
with text that explains the relevant hazard (see “Safety Labels on Instruments” on 
page x). These safety symbols may also appear next to DANGERS, WARNINGS, and 
CAUTIONS that occur in the text of this and other product-support documents.

Safety Labels on Instruments
The following CAUTION, WARNING, and DANGER statements may be displayed on 
Applied Biosystems instruments in combination with the safety symbols described in the 
preceding section. 

Symbol Description

Indicates that you should consult the manual for further information and to 
proceed with appropriate caution.

Indicates the presence of an electrical shock hazard and to proceed with 
appropriate caution.

Indicates the presence of a hot surface or other high-temperature hazard and to 
proceed with appropriate caution. 

Indicates the presence of a laser inside the instrument and to proceed with 
appropriate caution.

Indicates the presence of moving parts and to proceed with appropriate caution.

English Francais

CAUTION Hazardous chemicals. Read the 
Material Safety Data Sheets (MSDSs) before 
handling.

ATTENTION Produits chimiques dangeureux. 
Lire les fiches techniques de sûreté de 
matériels avant la manipulation des produits.

CAUTION Hazardous waste. Read the waste 
profile (if any) in the site preparation guide for 
this instrument before handling or disposal.

ATTENTION Déchets dangereux. Lire les 
renseignements sur les déchets avant de les 
manipuler ou de les éliminer.

CAUTION Hazardous waste. Refer to 
MSDS(s) and local regulations for handling 
and disposal.

ATTENTION Déchets dangereux. Lire les 
fiches techniques de sûreté de matériels et la 
régulation locale associées à la manipulation 
et l'élimination des déchets.

WARNING Hot lamp. AVERTISSEMENT Lampe brûlante.

WARNING Hot. Replace lamp with an 
Applied Biosystems lamp.

AVERTISSEMENT Composants brûlants. 
Remplacer la lampe par une lampe 
Applied Biosystems.

CAUTION Hot surface. ATTENTION Surface brûlante.

DANGER High voltage. DANGER Haute tension.
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General Instrument Safety

PHYSICAL INJURY HAZARD. Use this product only as 
specified in this document. Using this instrument in a manner not specified by 
Applied Biosystems may result in personal injury or damage to the instrument.

Moving and
Lifting the

Instrument

PHYSICAL INJURY HAZARD. The instrument is to be moved 
and positioned only by the personnel or vendor specified in the applicable site 
preparation guide. If you decide to lift or move the instrument after it has been installed, 
do not attempt to lift or move the instrument without the assistance of others, the use of 
appropriate moving equipment, and proper lifting techniques. Improper lifting can cause 
painful and permanent back injury. Depending on the weight, moving or lifting an 
instrument may require two or more persons.

WARNING To reduce the chance of electrical 
shock, do not remove covers that require tool 
access. No user-serviceable parts are inside. 
Refer servicing to Applied Biosystems 
qualified service personnel.

AVERTISSEMENT Pour éviter les risques 
d'électrocution, ne pas retirer les capots dont 
l'ouverture nécessite l'utilisation d'outils. 
L’instrument ne contient aucune pièce 
réparable par l ’utilisateur. Toute intervention 
doit être effectuée par le personnel de service 
qualifié de Applied Biosystems.

DANGER Class 3B laser radiation present 
when open and interlock defeated. Avoid 
direct exposure to laser beam.

DANGER Class 3B rayonnement laser en cas 
d’ouverture et d’une neutralisation des 
dispositifs de sécurité. Eviter toute exposition 
directe avec le faisceau.

DANGER Class 3B laser radiation when 
open. Avoid direct exposure to laser beam.

DANGER Class 3B rayonnement laser en cas 
d’ouverture. Eviter toute exposition directe 
avec le faisceau.

DANGER Class 2(II) laser radiation present 
when open and interlock defeated. Do not 
stare directly into the beam

DANGER de Class 2(II) rayonnement laser en 
cas d'ouverture et d'une neutralisation des 
dispositifs de securite. Eviter toute exposition 
directe avec le faisceau.

DANGER Class 2(II) laser radiation present 
when open. Do not stare directly into the 
beam. 

DANGER de Class 2(II) rayonnement laser en 
cas d'ouverture. Eviter toute exposition 
directe avec le faisceau.

DANGER Class 2(II) LED when open and 
interlock defeated. Do not stare directly into 
the beam.

DANGER de Class 2(II) LED en cas 
d'ouverture et d'une neutralisation des 
dispositifs de securite. Eviter toute exposition 
directe avec le faisceau.

DANGER Class 2(II) LED when open. Do not 
stare directly into the beam.

DANGER de Class 2(II) LED en cas 
d'ouverture. Eviter toute exposition directe 
avec le faisceau.

CAUTION Moving parts. ATTENTION Parties mobiles.

English Francais
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Moving and
Lifting Stand-

Alone Computers
and Monitors

Do not attempt to lift or move the computer or the monitor without 
the assistance of others. Depending on the weight of the computer and/or the monitor, 
moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:

• Make sure that you have a secure, comfortable grip on the computer or the monitor 
when lifting.

• Make sure that the path from where the object is to where it is being moved is clear 
of obstructions.

• Do not lift an object and twist your torso at the same time.

• Keep your spine in a good neutral position while lifting with your legs.

• Participants should coordinate lift and move intentions with each other before 
lifting and carrying.

• Instead of lifting the object from the packing box, carefully tilt the box on its side 
and hold it stationary while someone slides the contents out of the box.

Operating the
Instrument

Ensure that anyone who operates the instrument has:

• Received instructions in both general safety practices for laboratories and specific 
safety practices for the instrument.

• Read and understood all applicable Material Safety Data Sheets (MSDSs). See 
“About MSDSs” on page xii.

Chemical Safety

Chemical Hazard
Warning

CHEMICAL HAZARD. Before handling any chemicals, refer to 
the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all 
relevant precautions.

CHEMICAL HAZARD. All chemicals in the instrument, including 
liquid in the lines, are potentially hazardous. Always determine what chemicals have 
been used in the instrument before changing reagents or instrument components. Wear 
appropriate eyewear, protective clothing, and gloves when working on the instrument.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with 
shipments of hazardous chemicals to new customers. They also provide MSDSs with the 
first shipment of a hazardous chemical to a customer after an MSDS has been updated. 
MSDSs provide the safety information you need to store, handle, transport, and dispose 
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to 
replace the appropriate MSDS in your files.

Obtaining MSDSs You can obtain from Applied Biosystems the MSDS for any chemical supplied by 
Applied Biosystems. This service is free and available 24 hours a day. 
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To obtain MSDSs:

1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field, type in the chemical name, part number, or other information 
that appears in the MSDS of interest. Select the language of your choice, then click 
Search.

3. Find the document of interest, right-click the document title, then select any of the 
following:

• Open – To view the document

• Print Target – To print the document

• Save Target As – To download a PDF version of the document to a destination 
that you choose

4. To have a copy of a document sent by fax or e-mail, select Fax or Email to the left 
of the document title in the Search Results page, then click RETRIEVE 
DOCUMENTS at the end of the document list.

5. After you enter the required information, click View/Deliver Selected Documents 
Now.

Chemical Safety
Guidelines

To minimize the hazards of chemicals:

• Read and understand the Material Safety Data Sheets (MSDS) provided by the 
chemical manufacturer before you store, handle, or work with any chemicals or 
hazardous materials. (See “About MSDSs” on page xii.)

• Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (for example, safety glasses, gloves, or protective 
clothing). For additional safety guidelines, consult the MSDS.

• Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (for example, fume hood). For additional safety 
guidelines, consult the MSDS. 

• Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the 
manufacturer’s cleanup procedures as recommended on the MSDS.

• Comply with all local, state/provincial, or national laws and regulations related to 
chemical storage, handling, and disposal.

https://docs.appliedbiosystems.com/msdssearch.html
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Chemical Waste Safety

Chemical Waste
Hazard

HAZARDOUS WASTE. Refer to Material Safety Data Sheets and 
local regulations for handling and disposal.

CHEMICAL WASTE HAZARD. Wastes produced by Applied 
Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

Chemical Waste
Safety Guidelines

To minimize the hazards of chemical waste:

• Read and understand the Material Safety Data Sheets (MSDSs) provided by the 
manufacturers of the chemicals in the waste container before you store, handle, or 
dispose of chemical waste.

• Provide primary and secondary waste containers. (A primary waste container holds 
the immediate waste. A secondary container contains spills or leaks from the 
primary container. Both containers must be compatible with the waste material and 
meet federal, state, and local requirements for container storage.) 

• Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (for example, safety glasses, gloves, or protective 
clothing). For additional safety guidelines, consult the MSDS.

• Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (for example, fume hood). For additional safety 
guidelines, consult the MSDS.

• Handle chemical wastes in a fume hood.

• After emptying the waste container, seal it with the cap provided.

• Dispose of the contents of the waste tray and waste bottle in accordance with good 
laboratory practices and local, state/provincial, or national environmental and health 
regulations.

Waste Disposal If potentially hazardous waste is generated when you operate the instrument, you must:

• Characterize (by analysis if necessary) the waste generated by the particular 
applications, reagents, and substrates used in your laboratory.

• Ensure the health and safety of all personnel in your laboratory.

• Ensure that the instrument waste is stored, transferred, transported, and disposed of 
according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and 
disposal limitations may apply.
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Electrical Safety

ELECTRICAL SHOCK HAZARD. Severe electrical shock can 
result from operating the Applied Biosystems 3130/3130xl Genetic Analyzers without 
its instrument panels in place. Do not remove instrument panels. High-voltage contacts 
are exposed when instrument panels are removed from the instrument.

Power ELECTRICAL HAZARD. Grounding circuit continuity is vital for 
the safe operation of equipment. Never operate equipment with the grounding conductor 
disconnected.

ELECTRICAL HAZARD. Use properly configured and approved 
line cords for the voltage supply in your facility.

ELECTRICAL HAZARD. Plug the system into a properly 
grounded receptacle with adequate current capacity.

Overvoltage
Rating

The Applied Biosystems 3130/3130xl Genetic Analyzers system have an installation 
(overvoltage) category of II, and is classified as portable equipment.

Physical Hazard Safety

Moving Parts PHYSICAL INJURY HAZARD. Moving parts can crush and cut. 
Keep hands clear of moving parts while operating the instrument. Disconnect power 
before servicing the instrument.

Laser Safety

Laser
Classification

The Applied Biosystems 3130/3130xl Genetic Analyzers use an Argon laser. Under 
normal operating conditions, the instrument laser is categorized as a Class I laser. When 
safety interlocks are disabled during certain servicing procedures, the laser can cause 
permanent eye damage, and, therefore, is classified under those conditions as a Class 3B 
laser.

The Applied Biosystems 3130/3130xl Genetic Analyzers has been tested to and 
complies with 21 CFR, 1040.10 and 1040.11, as applicable.”

The 3130/3130xl Genetic Analyzers have been tested to and complies with standard 
EN60825-1, “Radiation Safety of Laser Products, Equipment Classification, 
Requirements, and User’s Guide.”
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Laser Safety
Requirements

To ensure safe laser operation:

• The system must be installed and maintained by an Applied Biosystems Technical 
Representative.

• All instrument panels must be in place on the instrument while the instrument is 
operating. When all panels are installed, there is no detectable radiation present. If 
any panel is removed when the laser is operating (during service with safety 
interlocks disabled), you may be exposed to laser emissions in excess of the Class 
3B rating.

• Do not remove safety labels or disable safety interlocks.

Additional Laser
Safety

Information

Refer to the user documentation provided with the laser for additional information on 
government and industry safety regulations.

LASER HAZARD. Lasers can burn the retina causing permanent 
blind spots. Never look directly into the laser beam. Remove jewelry and other items that 
can reflect the beam into your eyes. Do not remove the instrument top or front panels. 
Wear proper eye protection and post a laser warning sign at the entrance to the laboratory 
if the top or front panels are removed for service.

LASER BURN HAZARD. An overheated laser can cause severe 
burns if it comes in contact with the skin. DO NOT operate the laser when it cannot be 
cooled by its cooling fan. Always wear appropriate laser safety goggles.

Workstation Safety
Correct ergonomic configuration of your workstation can reduce or prevent effects such 
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your 
workstation to promote neutral or relaxed working positions.

MUSCULOSKELETAL AND REPETITIVE MOTION 
HAZARD. These hazards are caused by potential risk factors that include but are not 
limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy 
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

• Use equipment that comfortably supports you in neutral working positions and 
allows adequate accessibility to the keyboard, monitor, and mouse.

• Position the keyboard, mouse, and monitor to promote relaxed body and head 
postures.
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Safety and Electromagnetic Compatibility (EMC) Standards
This section provides information on:

• U.S. and Canadian Safety Standards

• Canadian EMC Standard

• European Safety and EMC Standards

• Australian EMC Standards

U.S. and
Canadian Safety

Standards

This instrument has been tested to and complies with standard UL 3101-1, “Safety 
Requirements for Electrical Equipment for Laboratory Use, Part 1: General 
Requirements.”

This instrument has been tested to and complies with standard CSA 1010.1, “Safety 
Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use, 
Part 1: General Requirements.”

Canadian EMC
Standard

This instrument has been tested to and complies with ICES-001, Issue 3: Industrial, 
Scientific, and Medical Radio Frequency Generators.

European Safety
and EMC

Standards

Safety

This instrument meets European requirements for safety (Low Voltage Directive 
73/23/EEC). This instrument has been tested to and complies with standards EN 61010-
1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and 
Laboratory Use, Part 1: General Requirements” and EN 61010-2-010, “Particular 
Requirements for Laboratory Equipment for the Heating of Materials.”

EMC

This instrument meets European requirements for emission and immunity (EMC 
Directive 89/336/EEC). This instrument has been tested to and complies with standard 
EN 61326 (Class B), “Electrical Equipment for Measurement, Control and Laboratory 
Use – EMC Requirements.”

Australian EMC
Standards

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits 
and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial, 
Scientific, and Medical (ISM) Radio-frequency Equipment.”
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Chapter 1

Maintenance

Overview This chapter covers the following topics:

Polymer Delivery Pump . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Performing Maintenance Tasks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Routine Cleaning  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Resetting the Instrument  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Moving and Leveling the Instrument . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Shutting Down the Instrument . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Wizards  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Flushing and Filling the Water Trap  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
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Notes

Polymer Delivery Pump

Components of the polymer delivery pump (PDP) are identified in the drawing below.

GR2459

PDP motor cover

PDP motor
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Array port

Capillary array tip

Piston

Pump block

Check valve

Polymer supply
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Syringe fitting
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supply bottle
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Buffer fill-line

Buffer jar (16 mL anode reservoir)
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Overflow hole

Water seal
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Buffer valve pin
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Interconnect tube
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Waste fitting
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1
Performing Maintenance Tasks

Overview This section lists common tasks required to maintain your Applied Biosystems 
3130/3130xl Genetic Analyzers in good working condition. The tasks are divided into 
tables based on how often you should perform each task.

 Wear appropriate protection, including gloves, laboratory goggles, 
and coat whenever you work with the fluids used on this instrument, or parts that may 
come into contact with these fluids.

Daily Tasks Perform these tasks at least once per day.

Maintenance Task Frequency

Ensure adequate levels of buffer and water in reservoirs. Before each run

Ensure the plate assemblies are properly assembled. 

IMPORTANT! The holes in the plate retainer must align with the 
holes in the septa, or the capillary tips will be damaged.

Before each run

Ensure the plate assemblies are positioned on the plate deck properly. 
Plates should sit snugly on the deck. 

IMPORTANT! Never use warped plates.

Before each run

Check the level of buffer in the buffer jar. Ensure that the overflow hole 
faces the front of the instrument and is not occluded.

Before each run

Replace the water and 1X run buffer in the reservoirs on the instrument 
and make sure that the outside of the assemblies are dry.

Every 48 hours

Check for bubbles in the pump block, lower polymer block, 
interconnect tube, polymer supply tube, and channels.

Remove all bubbles with the Bubble Remove wizard.

Daily or before each 
run

Check the loading-end header to ensure the capillary tips are not 
crushed or damaged.

Daily or before each 
run

Check the level of polymer in the bottle to ensure sufficient volume for 
runs.

Daily or before each 
run

Check the pump block and the lower polymer block to ensure they fit 
securely on the instrument.

Daily

Clean the instrument surfaces. Daily

Check for leaks around the array knob, interconnecting tube nuts, and 
check valve.

Daily
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Weekly Tasks Perform these tasks at least once per week.

Monthly Tasks Perform these tasks at least once per month.

As-Needed Tasks Perform these tasks as needed.

Maintenance Task Frequency

Replace the polymer using the Replenish Polymer Wizard. Weekly or as 
needed

Flush the water trap. See “Flushing and Filling the Water Trap” on 
page 13.

Weekly

Check the storage conditions of the used arrays. Weekly

Restart the computer and instrument. Weekly

Maintenance Task Frequency

Run the Water Wash Wizard. 

Flush the array port during this wizard, whether or not bubbles are 
present in the array port.

Monthly or as 
needed

Defragment the hard drive. Monthly

Maintenance Task Frequency

Clean the drip tray. As needed

Change the array. As needed

Remove any dried polymer from the capillary tips. Use a lint-free wipe 
moistened with deionized water.

As needed
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1
Routine Cleaning

General Cleaning 

1. Ensure the oven and instrument doors are closed.

2. Press the Tray button on the front of the 
instrument to move the autosampler to the 
forward position.

IMPORTANT! Never use organic solvents to 
clean the instrument.

3. Wipe off any liquid on or around the autosampler 
using a lint-free tissue.

4. Clean off any polymer build-up (crystals) on the 
instrument including the capillary tips and the 
stripper plate with deionized water and lint-free 
tissue.

5. Clean the array port knob, plug, or opening 
threads of these parts with moistened lab wipes.

6. Clean out the drip trays with deionized water and 
lint-free tissue.

Resetting the Instrument 
Reset the instrument when:

� A fatal error as indicated by the red status light
� The instrument does not respond to the 

3130/3130xl Data Collection software

Tray button
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Two procedures can reset the instrument: 

� Press the reset button through the pin hole on the 
front of the instrument to dump and reload the 
firmware and to reset the electronics. Try this 
method first.

� Shut down and restart the computer and the 
instrument. 

Resetting With the Reset Button

1. Close the instrument doors.

2. Using a long narrow implement, such as a 
straightened paper clip, press the reset button on 
the front of the instrument.

Resetting by Powering Down

1. Close the instrument doors.

2. Power off the instrument by pressing the on/off 
button on the front of the instrument.

3. Restart the computer.
a. Select Start > Turn off Computer.
b. In the dialog box, select Restart, then click 

OK.

IMPORTANT! Wait until the computer has 
completely restarted before proceeding.

4. Turn on the instrument, then wait for the solid 
green light.

5. Launch the Data Collection software (Service 
Console applications start automatically).

Reset button

On/Off button
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Notes

1
Moving and Leveling the Instrument

PHYSICAL INJURY HAZARD. 
Do not attempt to lift the instrument or any other 
heavy objects unless you have received related 
training. Incorrect lifting can cause painful and 
sometimes permanent back injury. Use proper lifting 
techniques when lifting or moving the instrument. 
Two or three people are required to lift the instrument, 
depending upon instrument weight.

1. Remove the following components from the 
instrument:

� Any plate assemblies from the autosampler.
� Water and buffer reservoirs from the 

autosampler.
� Capillary array, by selecting Instrument 

Shutdown Wizard. (See �Performing a 
Long-Term Shutdown� on page 10.)

� Anode buffer reservoir.

2. Switch off the breaker on the back of the 
instrument. 

3. Disconnect the power cord and the Ethernet 
cable.

IMPORTANT! While moving the instrument, 
avoid any shock or vibration.

4. Move the instrument.

5. Place the bubble level on the autosampler deck.

6. Turn the instrument legs to level the instrument.

To move the 
instrument corner ... Turn the leg ...

up right (clockwise)

down left (counterclockwise)
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Shutting Down the Instrument
Perform the appropriate shutdown procedure based on 
the information in the following table:

Performing a Short-Term Shutdown

Fill the Capillary With Fresh Polymer Using Manual 
Control

1. Ensure the oven and instrument doors are closed.

2. Collect polymer waste:
a. Click GA Instruments > ga3130 or 

ga3130xl> instrument 
name> Manual Control.

b. In the Send Defined Command drop-down 
menu, select Autosampler.

c. In the Command Name drop-down menu, 
select Move autosampler to site.

d. In the Value menu, select Waste.
e. Click Send Command. Wait for the 

autosampler to stop moving and Send 
Command becomes active, before 
proceeding.

3. Fill the capillaries:
a. In the Send Defined Command for drop-

down menu, select Polymer Delivery 
Pump.

If the instrument will be 
unattended for ... Perform this shutdown procedure ...

no more than 1 week with a full 
buffer reservoir

Short-term

IMPORTANT! The key to a successful 
short-term shutdown is keeping the capillary 
array in 1X running buffer. This prevents the 
polymer from drying in the capillaries.

for more than 1 week Long-term
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1

b. In the Command Name, select the 
appropriate Fill <length> cm capillary array 
length.

c. Click Send Command.The array fill is 
finished when Send Command becomes 
active.

d. Return the buffer reservoir to the capillaries.

Cleaning the Reservoirs

1. Press the Tray button to move the autosampler 
forward.

2. Open the doors, then remove the: 
� Plates 
� Cathode buffer reservoir and water 

reservoirs 

3. Dispose of remaining fluids and rinse out the 
reservoirs with deionized water.

Note: Follow your company�s waste disposal 
practices for appropriate disposal procedures. 

4. Rinse the cathode reservoir with 1X running 
buffer, and then fill to the line with 1X running 
buffer (about 16 mL).

5. Fill the three water reservoirs to the line with 
quality deionized water (about 16 mL). 

Be sure that the septa fit snugly 
and flush on the tops of the reservoirs in order to 
prevent damaging the capillary tips.

6. Place a clean reservoir septa on each reservoir, 
and dry the outside of the reservoirs using a 
lint-free wipe.

G
R

18
57

b

Fill line
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7. Place the reservoirs into position on the 
autosampler as shown below.

8. Close the instrument doors.

Note: Closing the doors returns the autosampler 
to the home position, placing the tips of the 
capillaries in buffer.

9. Shut down the computer and turn off the 
instrument.

Performing a Long-Term Shutdown

Select Instrument Shutdown Wizard and follow the 
prompts.

IMPORTANT! Make sure all parts are completely 
dry before long-term storage.

Water reservoir
(waste)

Cathode reservoir
(1X running buffer)

Water reservoir
(rinse)

Water reservoir 
(spare)

Home position
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1
Wizards

Accessing
Wizards

In the tree pane of the Data Collection software, click 
GA Instruments > ga3130 or ga3130xl > instrument name or any topic 

name below instrument name to see Wizards in the menu bar.

The wizards in the Data Collection software guide you through several maintenance 
procedures.

If plates are linked in the Run Scheduler and you complete a wizard, the plates 
automatically unlink. You will get a warning dialog box. Click , and then relink the 
plate if applicable.

General Use
Guidelines

The following table lists the wizards and when to use them.

Wizard Use to...

Install Array • Install a capillary array:

– On a new instrument

– To reactivate an instrument that has been shut down

• Replace an installed capillary array with another capillary array

Change Polymer 
Type

• Change to a different polymer type than the one presently being 
used

Replenish Polymer • Replenish the polymer supply 

• Replace the polymer in the PDP with polymer of the same or 
different lot

• Enter polymer information when Data Collection software is installed 
or upgraded

Bubble Remove Remove bubbles in the PDP chamber, channels, and tubing
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Water Wash • Wash the PDP chamber, lower polymer blocka, channels, and tubing 
with water:

– As part of a monthly maintenance protocol

– To remove any suspected contaminants in the PDP

– To remove persistent bubbles (followed by the Bubble Remove 
Wizard, if needed)

– To replace old polymer in the PDP

Instrument 
Shutdown

Prepare the instrument for a period of disuse of greater than one week

Autosampler 
Calibration

Calibrate the autosampler positions

Update Cap Array 
Info

• Update the capillary array information and the serial number

• Correct an entry mistake after using a wizard

a The lower polymer block is cleaned on the instrument using this wizard and should not be 
removed.

Wizard Use to...
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1
Flushing and Filling the Water Trap

Overview

The PDP water trap should be flushed with either 
distilled or deionized water at least once per week to 
wash out any diluted polymer and to clear bubbles. 
Leave the trap filled with either distilled or deionized 
water.

To flush the water seal trap:

1. Fill the supplied 20 mL, all-plastic Luer lock 
syringe (in the PDP Cleaning kit, PN 4359572) 
with distilled or deionized water. Expel any 
bubbles from the syringe. 

2. Do not use a syringe smaller than 20 mL. Doing 
so may generate excessive pressure within the 
trap.

3. Attach the syringe to the forward-facing Luer 
fitting at the top of the pump block. Hold the 
fitting with one hand while threading the syringe 
onto the fitting with the other hand.

4. Open the Luer fitting by grasping the body of the 
fitting and turning it and the attached syringe 
approximately one-half turn counterclockwise.

5. Open the exit fitting at the top left side of the 
pump block by turning it approximately one-half 
turn counterclockwise.
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6. Hold an empty tube or beaker under the exit 
fitting to receive approximately 5 mL of waste. 
Flush the trap by pushing steadily on the syringe 
plunger.

IMPORTANT! DO NOT USE EXCESSIVE 
FORCE when you push the syringe plunger as 
this may damage the trap seals. Take 
approximately 30 seconds to flush 5 mL of either 
distilled or deionized water through the trap.

Note: Because the water trap volume is 
approximately 325 µL, a relatively small volume 
of water is adequate for complete flushing. 
However, a larger volume only improves 
flushing as long as force and flow rate are kept 
within the limits given above.

7. Close the fittings in this order by turning each 
clockwise until the fittings seal against the block:

a. Luer fitting
b. Exit fitting 

IMPORTANT! Do not over-tighten the fittings. 
Very little pressure develops within the trap 
during pump operation, so the fittings require 
only enough tightening to prevent water leaks. 
Excessive tightening can damage the fittings.

c. Remove the syringe from the Luer fitting. 
Hold the fitting with one hand while turning 
the syringe counterclockwise with the other 
hand.
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1
Fluids and Waste

When to Change the Buffer

CHEMICAL HAZARD. 10X 
Genetic Analyzer Buffer with EDTA may cause eye, 
skin, and respiratory tract irritation. Read the MSDS, 
and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

Change the buffer before each batch of runs or at least 
every 24 hours.

Making Buffer for a Single Run

To prepare 50 mL of 1X running buffer:

1. Add 5 mL of 10X Genetic Analyzer buffer into a 
graduated cylinder.

2. Add deionized water to bring the total volume up 
to 50 mL.

3. Mix well.

Storing the Buffer

The 1X running buffer can be stored at: 

� 2 to 8 °C for up to 1 month
� Room temperature for 1 week

50 mL 
total 45 mL DI H2O

5 mL 10X Genetic 
Analyzer buffer

50 mL graduated cylinder

Buffer Storage Conditions

Option A Option B

Su M T W Th F S

2 °C to 
8 °C

1 month

20 °C to 
25 °C

7 days

Su M T W Th F S
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Polymer

Storing Polymer

Store any remaining POP� polymer at 2 to 8 °C until 
the expiration date printed on the jar. 

Note: Excessively hot environments may shorten the 
working life of the polymer.

When to Change the Polymer

Change the polymer weekly. The polymer is good at 
25 °C for about 7 days.

Before Using the Polymer

1. Remove the polymer from 4 °C storage.

2. Loosen the cap and bring the polymer to room 
temperature. 

3. To dissolve deposits, tighten the cap and gently 
swirl the polymer.

Replenishing the Polymer

CHEMICAL HAZARD. POP� 
Polymers causes eye, skin, and respiratory tract 
irritation. Read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

IMPORTANT! Wear gloves when you 
handle the polymer.

POP™-4 or POP™-6 Polymer 
Storage Conditions

Su M T W Th F S

20 °C to 25 °C 7 days
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1. Click Wizards > Replenish Polymer Wizard.

2. Follow the directions given in the wizard to load 
fresh polymer on the instrument.

3. Relink plate(s), if applicable.

Changing to a Different Polymer Type

CHEMICAL HAZARD. POP 
Polymers causes eye, skin, and respiratory tract 
irritation. Read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

IMPORTANT! Wear gloves when you 
handle the polymer.

1. Click Wizards > Change Polymer Type 
Wizard.

2. Follow the wizard prompts.
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Capillary Array

When to Change
a Capillary Array

A capillary array should last approximately 100 runs. 

The following problems may indicate that a new capillary array is required: 

� Poor sizing precision or allele calling
� Poor resolution and/or decreased signal intensity

Checking the
Cathode Bar

ELECTRICAL SHOCK/FIRE HAZARD. Do not leave liquid on 
the cathode header. This can lead to electric shock or even fire if not properly 
maintained.

When placing a used array back on the instrument, be sure that the cathode bar is dry 
(see figure below). A wet bar could lead to arcing.

Installing, Removing, or Replacing a Capillary Array

IMPORTANT! Wear gloves when you handle the polymer blocks.

CHEMICAL HAZARD. POP polymer causes eye, skin, and 
respiratory tract irritation. Read the MSDS, and follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and gloves.

1. Close the oven and instrument doors, and then press the Tray button.

Back view: Ensure the cathode header is dry – especially in the center

G
R

21
46

3130 xl capillary array 3130 capillary array
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1

2. Select Wizards > Install Array Wizard.

IMPORTANT! The capillary array length defined 
in the wizard must match the array length you are 
using. 

3. Open instrument and oven doors.

4. Follow the directions given in the wizard to 
install or replace an array.

5. Click  when done.

6. Close and lock the oven door, then close the 
instrument doors.

IMPORTANT! If you installed or replaced an 
array that is a different length than the one you 
were using, you must reset the active spectral 
calibration or create a new spectral calibration 
for the dye set and array length combination (see 
�Activating a Spectral Calibration� in the 
Applied Biosystems 3130/3130xl Genetic 
Analyzers Getting Started Guide). 

7. Relink plate(s), if applicable.
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Updating
Capillary Array

Information

Use the Update Cap Array Info wizard to:

� Update the capillary array length and serial number information into the database
� Correct an entry error after using another wizard

IMPORTANT! The capillary array length defined in the wizard must match the array 
length you are using.

Caring for the
Capillary Array
and Work Area

Follow these guidelines to properly care for the capillary array and area:

� Wear gloves and handle the capillary array gently.
� Do not touch the detection cell. 
� Keep the ends of the capillary array wet at all times.
� Do not overtighten the capillary array knob.

� Clean off any polymer buildup (crystals) on the instrument, including the capillary 
electrodes and the stripper plate, with deionized water and lint-free tissue.

CHEMICAL HAZARD. POP polymer causes eye, skin, and 
respiratory tract irritation. Read the MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, and gloves.

Note: When cleaning the capillary electrodes, be careful not to bend them out of 
position. If the electrodes do get bent, follow the procedure �Storing Capillary 
Arrays� on page 21.

IMPORTANT! Never use organic solvents to clean the instrument.

Filling the
Capillary Array
Using Manual

Control

See �Fill the Capillary With Fresh Polymer Using Manual Control� on page 8.

Keep 
clean
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Storing Capillary Arrays

Storing a Capillary Array on the Instrument

Store the capillary array on the instrument only when 
the capillary array will be unused for less than 1 week.

To store the capillary array on the instrument, follow 
the instructions to perform a short-term shutdown 
described on page 8. 

Storing a Capillary Array off the Instrument

Store the capillary array off of the instrument when 
the capillary array will be unused for longer than 
1 week.

IMPORTANT! Before storing the capillary array for 
long periods, fill the capillaries with fresh polymer.

IMPORTANT! Wear gloves while performing the 
following procedure, and any other time you handle 
the capillary array, septa, or buffer reservoirs.

CHEMICAL HAZARD. POP 
Polymer causes eye, skin, and respiratory tract 
irritation. Read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

1. Remove the capillary array from the instrument 
by selecting Install Array Wizard.

2. Select Store Array and follow the prompts.

3. Replace the cover over the detection cell.

4. Fill a buffer reservoir with fresh 1X running 
buffer and cover with a septa strip. Insert the 
capillary tips into the buffer.

5. Fill the shipping vial with fresh 1X running 
buffer and insert the detection end of the 
capillary array. 
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6. Store the capillary array upright. 

7. Check the 1X running buffer level in the 
reservoir and tube weekly and replenish the 
buffer as needed.

Removing Bubbles from the Polymer 
Blocks

Bubbles may be found in the polymer system, 
especially after a polymer change or array installation. 

Remove the bubbles from all parts of the polymer 
system including the pump chamber, the pump block 
channel, polymer supply and interconnect tubing and 
the lower polymer block channel.

To clear bubbles:

1. Select Wizards > Bubble Remove Wizard to 
clear bubbles.

IMPORTANT! Remove bubbles from the 
interconnect tubing and the channel of the lower 
polymer block. These areas are part of the 
electrophoresis current path. Absence of bubbles 
in the current path is important for problem-free 
electrophoresis.

2. Replace the buffer if excess polymer is expelled 
into the anode buffer jar during bubble removal.
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Autosampler Calibration

When to Calibrate the Autosampler

Calibrate the autosampler only as needed.

Symptoms of autosampler alignment problems may 
include:

� Poor injection for a small number of capillaries
� Low signal strength
� No evidence of sample

Calibrating the Autosampler

1. Close the oven and instrument doors.

2. Select Wizards > Autosampler Calibration 
Wizard. 

3. If plates are linked in the Run Scheduler, the 
plates automatically are unlinked. In the Warning 
dialog box, click .

4. Follow the directions given in the wizard to 
calibrate the autosampler.

5. Click  and turn the instrument power off 
for 10 sec then on.
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Manual Control

Note: Manual control is active only if the oven and instrument doors are closed.

Table of
Commands

The following table displays the manual control options in the Data Collection software.

Command Function Command Options Value

Electrophoresis Turn On/Off power 
supply

• On

• Off

Set voltage A number between 0.0 and 15 kV

Read voltage N/A

Read current

Laser Set laser state • Idle

• On

• Off

Set laser power A number between 0 and 25 mW

Read laser power 
setting

N/A

Read laser power

Read laser current

Open/Close shutter • Open

• Closed

Oven Set state • On

• Off

Set temperature A number between 18 and 65 °C

Autosampler Initialize 
autosampler

N/A

Bring autosampler 
to forward position

Initialize and return 
to previous position

Move autosampler 
up/down

A number between –500 and 500 steps

Move autosampler 
to site

• Buffer (left, front for 1X running buffer), 
home position

• Water1 (left, rear for deionized water)

• Water2 (right, front for deionized water)

• Waste (right, rear for deionized water)
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1Polymer Deliver Pump Initialize polymer 
delivery pump

N/A

Home piston

Read piston 
position

Move piston down 1 to 38000 counts

Move piston up 1 to 38000 counts

Fill capillary array 1 to 38000 counts 

Buffer Valve Close /Open buffer 
valve

• Close

• Open

Detection Cell Heater Turn On/Off 
detection cell 
heater

• On

• Off

Read detection cell 
heater temperature

N/A

Oven Turn On/Off oven • On

• Off

Set oven 
temperature

A number between 18 and 70 °C

Read oven 
temperature

N/A

Command Function Command Options Value
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Using Manual Control

Note: Manual control functions cannot be used 
during a run.

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130 or 
ga3130xl> instrument name> Manual 
Control.

2. In the Send Defined Command For drop-down 
list, select a function.

3. In the Command Name drop-down list, select a 
command and enter a value, if required.

Note: The command names are filtered based 
the function selected in step 2.

4. Click .
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Chapter 2

2

Computer Maintenance

Overview This chapter covers the following topics:

Computer Task Lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Working With Drives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Hard Disk and Database Status  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
Archiving Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Defragmenting the Computer Hard Drive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Deleting Records from the Database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
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Computer Task Lists

Weekly Tasks Perform this task at least once per week.

Working With Drives

Checking
Available Space

on All Drives

Before a run or batch of runs, the Data Collection software checks the space on drives C, 
D, E, and F to ensure that there is sufficient space to store the newly created database and 
sample file data. The Data Collection software sends a warning message:

� Remove data� the drive is getting full 
� Clean up the database (when the database is getting full, ~70 to 75% of capacity) 

View the Errors pane�s Instrument Status window for generated errors and in the Event 
Log window. Also, check the status light in the bottom left-hand corner of the data 
collection window to see if it flashes red.

Full Database
Error

To view the error messages, click GA Instruments > ga3130 or ga3130xl > 
instrument name > Instrument Status> Event Log.

Database full error message

Maintenance Task Frequency

Check database space. Weekly

Delete plate records from the instrument database and archive sample 
files.

Restart the computer and instrument
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Disk Drive Full
Error

To view the error messages, click GA Instruments > ga3130 or ga3130xl > 
instrument name > Instrument Status > Event Log.

Disk drive full error message

Runs can not start until data is removed from the drive and/or database is cleaned up.

Cleaning Drives Ensure that you have sufficient drive space by regularly:

� Archiving data
� Deleting unneeded files
� Emptying the trash
� Defragmenting the drives

Status light
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Hard Disk and Database Status

Manually Checking Available Disk Space 
on Drive E

1. In the tree pane of the Data Collection software, 
click GA Instruments >  Database 
Manager to open the Database Manager.

2. Check the Database Status section. The Data 
Collection software will prompt you when it is 
70-75% full. At 78% full, the software will not 
start a run.

3. If there is insufficient space:
a. Archive the sample files to a CD-RW (see 

page 31) or another volume.
b. Delete the sample file data from the drive E 

and empty the contents of the Recycle Bin.

Check disk space status here

Check the Database Status section
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Archiving Data
A basic version of Roxio Easy CD Creator� 5 
software is loaded on your Dell� computer. Use this 
software to archive data to a CD. The software is also 
part of the CD set you received with your Dell 
computer.

Creating a Data CD

1. Select Start > All Programs > Roxio Easy CD 
Creator 5 > Applications > Easy CD Creator.

The Untitled - Easy CD Creator dialog box 
opens.

Optional: For help creating a data CD, select 
Help Topics> Contents tab.

2. In the left tree pane, select Making Data CDs 
for Archiving and Sharing > Making a Data 
CD.
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3. Follow the instructions to create the CD.

Instructions for creating a data CD
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Defragmenting the Computer Hard Drive
The fragmentation of files decreases the performance 
of both the Data Collection software and the computer 
operating system. Programs take a longer time to 
access files by performing multiple search operations 
of the fragments. 

When to Defragment the Computer Hard 
Drive

Defragment the computer hard drive:

� At least once every month.
� Before fragmentation reaches 10%.

Defragmenting the Drives

1. In the Windows desktop, right-click 
My Computer, then select Manage.

2. In the tree tab of the Computer Management 
dialog box, click Computer Management 
(Local) > Disk Fragmenter.

3. Select the E drive.

4. Click .
The computer displays the Defragmentation 
Complete dialog box after completing the 
defragmentation.

5. In the Defragmentation Complete dialog box, 
click .

6. In the Computer Management dialog box, 
click .
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Deleting Records from the Database 

Deleting Processed Frame Data

The Cleanup Database utility 
deletes all run data and plate records in the database. 
Before running the utility, be sure that all runs have 
been extracted from the database.

1. In the tree pane of the Data Collection software, 
click GA Instruments > Database 
Manager to view the Database Manager.

2. Click Cleanup Processed Plates.

The following dialog box opens.

3. Click .

Note: The spatial and spectral calibrations are 
not deleted.

Note: It may take several minutes to clean up the 
database if it contains a lot of data or is full.
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Deleting a Spectral Calibration
• Spectral calibrations can be deleted by deleting 

the spectral plate associated with the spectral 
calibration only after deleting all processed 
plates associated with the spectral plate.

Processed plates are associated with a spectral 
plate if the plates used the spectral plate's 
calibration as the active calibration when it was 
processed.

• Delete spectral plates that are not associated with 
any processed plates directly in the Plate 
Manager.

Option one: Delete a spectral plate after performing 
the Cleanup processed plate procedure.

Note: Use this option if you want to delete many 
spectral plates, and you don't mind deleting all 
processed plate data from the database. 

1. Clean up all processed plates by using the 
Database Manager. See “Deleting Processed 
Frame Data” on page 34.

2. Select the Plate Manager view.

3. Select a spectral plate that you want to delete.

4. Click Delete.

5. Repeat steps 3 and 4 as needed.
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Option two: Delete a spectral plate after deleting its 
associated processed plates manually. 

Note: Use this option if you are trying to delete one 
or two spectral plates and you do not want to delete all 
the processed plates in the database.

1. Select the Plate Manager view.

2. Search for and select a processed plate associated 
with the spectral calibration you are trying 
delete.

3. Click Delete to delete the processed plate.

4. Repeat steps 2 and 3 until all associated 
processed plates are deleted.

5. Search for and select the spectral plate that you 
want to delete.

6. Click Delete.
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Troubleshooting

Overview This chapter includes troubleshooting the following topics:

Instrument Startup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Instrument Status  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Spatial Calibration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Spectral Calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Plate Linking  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Run Performance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
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Instrument Startup

Troubleshooting instrument startup (see also H1-
Heading1“Instrument Status” on page 39)  

Observation Possible Cause Recommended Action

No communication between the 
instrument and the computer. 
The event viewer is blank.

Incorrect Ethernet configuration. Check the configuration of the IP address. 

1. Select Start > All Programs > Accessories > 
Command Prompt.

2. At the C:\ prompt, type
IPconfig /all.

3. Press Enter. The command prompt window 
displays information on the network.

4. Ensure the IP address for Ethernet adapter 1 is 
set for the machine (i.e., the motherboard 
Ethernet connection). The correct IP address is: 
192.168.0.1

Note: The local IT group should use Adapter 2 for 
networking.

Instrument red light is blinking. Incorrect start up procedure. Start up in the following sequence:

1. Log out of the computer.

2. Turn off the instrument.

3. Boot up the computer.

4. After the computer has booted completely, turn 
the instrument on. Wait for the green status light 
to come on.

5. Launch the Data Collection software.

Data Collection software will not 
launch.

Applications in the Service 
Console did not start properly.

(It takes several minutes before 
data collection software opens.)

Restart the computer.

Computer screen is frozen. Communication error. There will be no loss of data. However, if the 
instrument is in the middle of a run, wait for the run 
to stop. Then, exit the Data Collection software 
and restart as described above.

Autosampler does not move to 
the forward position.

Possible communication error. Restart the system, and then press the Tray button.

Oven or instrument door is not 
closed.

1. Close and lock the oven door.

2. Close the instrument doors.

3. Press the Tray button.

Instrument does not respond to 
commands immediately after 
closing the doors.

Autosampler reinitializes its 
location.

Wait for the autosampler to home before 
continuing.
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Instrument Status

Troubleshooting instrument status (see also H1-
Heading1“Instrument Startup” on page 38)

Observation Possible Cause Recommended Action

The yellow light in the LED panel 
on the bottom left-hand corner 
of the instrument remains solid 
yellow.

A Power override is enabled Cycle power on the system in the following order:

a. Boot/Reboot the computer workstation.

b. Log in to the computer workstation.

c. Ensure that the buffer, water, and waste 
reservoirs are in their appropriate stations.

d. Close the oven door.

e. Close the stacker drawer.

f. Close the instrument doors.

g. Cycle power on the Applied Biosystems 
3130 Series Genetic Analyzer.

The account password for User 
name “3130User” has changed 
or has been entered with the 
wrong case (the user name and 
password are case-sensitive).

1. Boot/Reboot the instrument and computer 
workstation.

2. Log in, taking care to type 3130User with the 
capitalization shown here. 

The account password for User 
name “3130User” is expired or 
corrupt.

Start up in the following sequence:

1. Log out of the computer and turn off the 
instrument.

2. Boot up the computer.

3. After the computer has booted completely, turn 
the instrument on. Wait for the green status light 
to come on.

IMPORTANT! Do not launch the Data Collection 
software.

4. Reset the account password:

a. Right click “My Computer”.

b. Click “Manage”.

c. In the Computer Management window, click 
“Local Users and Groups”, then click “User”.

d. On the right side of the window, right-click 
“3130User”, then select “Set Password”.

e. Set the password to “3130User”, confirm the 
password entry, then click “OK”.

f. In the Computer Management window, right-
click “3130User” and select “Properties”.

g. Confirm “User cannot change password” 
and “Password never expires” are 
selected.Click “OK” then exit out of the 
Computer Management window.
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The yellow light in the LED panel 
on the bottom left-hand corner 
of the instrument remains solid 
yellow. (continued)

The original communication 
cable is loose, has been 
replaced with a standard cable 
or is improperly attached.

• Only the communication cable shipped with the 
instrument can be used as it is specifically 
designed for the instrument. 

• Confirm that the original communication cable 
is attached snugly, with the “computer”-labeled 
end attached to computer and “instrument”-
labeled end attached to instrument. 

Computer network configuration 
or access has changed. 

Confirm the following are unchanged:

• The name of the computer workstation

• The firewall/antiviral software on the computer 
workstation

• The original IP address of the 
computer/network card

• The computer configuration for network access

• The Operating System/Service Pack

The instrument software can not 
find the “3130calib.ini” file.

Confirm that the Instrument Data Collection 
Software “3130calib.ini” file is in the appropriate 
location:

• For the Applied Biosystems 3130 Genetic 
Analyzer Software v1.0, look in:

C:/3130/Firmware

• For the Applied Biosystems 3130 Genetic 
Analyzer Software v2.0 and v3.0, look in:

C:/AppliedBiosystems/Firmware

If the problems persists, contact Applied Biosystems Technical Support or Technical 
Assistance Center. 

Troubleshooting instrument status (see also H1-
Heading1“Instrument Startup” on page 38) (continued)

Observation Possible Cause Recommended Action
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Spatial Calibration

Troubleshooting spatial calibration

Observation Possible Cause Recommended Action

“Start” Spatial Calibration button 
is disabled.

Communication failure between 
the Data Collection Software and 
Sequencing Instrument.

Install Software Patch CE_DC_300-002. To 
download the patch, go to 
http://www.appliedbiosystems.com, then click the 
link for Support, then Software Downloads, then 
Applied Biosystems 3130/3130xl Genetic Analyzer, 
then Updaters and Patches. To install the patch, 
follow the instructions in the Read Me pdf file.

Unusual peaks or a flat line for 
the spatial calibration.

The instrument may need more 
time to reach stability. An 
unstable instrument can cause a 
flat line with no peaks in the 
spatial view.

Repeat the spatial calibration.

Improper installation of the 
detection cell.

Reinstall the detection cell to reposition and make 
sure it fits in the proper position. 

If the calibration fails again:

1. Fill the capillaries with polymer.

2. Repeat the spatial calibration.

Broken capillary resulting in a 
bad array fill.

Check for a broken capillary, particularly in the 
detection cell area. If necessary, replace the 
capillary array using the Install Array Wizard.

Persistently bad spatial 
calibration results.

Bad capillary array. Replace the capillary array, and then repeat the 
calibration. Call Technical Support if the results do 
not improve.
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Spectral Calibration 
Tip: Magnifying the Spectral Profile or Raw Data

1. In the tree pane of the Data Collection 
software, click 

GA Instruments > ga3130xl or 
ga3130 > instrument 
name > Spectral Viewer.

2. In the spectral profile or raw data display, 
click-drag the cursor to create a box 
around the area of interest.

3. Release the mouse button. 

The Data Collection software displays the 
selected region.

4. Press the r key to reset the view.

Selecting an area to magnify in a spectral profile

Magnified area of that spectral profile

Troubleshooting spectral calibration

Observation Possible Cause Recommended Action

No signal. Incorrect preparation of sample. Replace samples with fresh samples 
prepared with fresh Hi-Di™ 
formamide.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and 
respiratory tract irritation. It is a 
possible reproductive and birth defect 
hazard. Read the MSDS, and follow 
the handling instructions. Wear 
appropriate protective eyewear, 
clothing, and gloves.

Bubbles in sample tray. Centrifuge samples to remove 
bubbles.

Autosampler not correctly aligned. The 
capillary tips may be hitting the bottom 
of the wells, or they may not be 
touching the samples.

Check the autosampler calibration. If 
necessary, recalibrate the autosampler 
using the Autosampler Calibration 
Wizard.
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If the spectral calibration fails, or if a 
message displays “No candidate 
spectral files found.”

Blocked capillary. Refill capillary array. You may have to 
install a fresh array or consider that 
capillary non-usable for purposes of 
planning your runs.

Incorrect chemistry file, dye set, and/or 
run module selected.

Correct the files and rerun the 
calibration.

Insufficient filling of array. Check for broken capillaries and refill 
the capillary array.

Expired matrix standards or old 
reagents.

Check the expiration date and storage 
conditions of the matrix standards 
and/or reagents. If necessary, replace 
with a fresh lot.

Data Error - One or more peaks fall 
below the minimum required amplitude 
of 750.

One or more peaks fall below the 
minimum required amplitude of 750.

Rerun the spectral standards, and if 
necessary, increase the amount of 
spectral standard added.

Spikes in the data or “Bad dye order 
detected” error message.

Expired polymer. Replace the polymer with a fresh lot 
using the Replenish Polymer Wizard.

CHEMICAL HAZARD. 
POP-4™ polymer, POP-6™ polymer, and 
POP-7™ polymer cause eye, skin, and 
respiratory tract irritation. Read the 
MSDS, and follow the handling 
instructions. Wear appropriate 
protective eyewear, clothing, and 
gloves.

Bubbles in the polymer system. Select the Bubble Remove Wizard to 
clear the bubbles.

Possible contaminant or crystal 
deposits in the polymer.

Properly bring the polymer to room 
temperature; do not heat to thaw 
rapidly. Swirl to dissolve any solids.

Replace the polymer if it has expired.

Troubleshooting spectral calibration (continued)

Observation Possible Cause Recommended Action

WARNING!
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Troubleshooting failing capillaries

Failing Capillary assigned a spectral profile

If a capillary fails, it is automatically assigned the spectral profile of its nearest passing capillary. 

For applications where pull-up and pull-down peaks cause critical errors, repeat the spectral calibration and use a unique 
spectral for each capillary array length and polymer type.

Manually Overriding a Spectral Profile

To override a spectral calibration profile:

1. Review the data.

2. In the plate diagram, select the capillary spectral 
profile you want to override.

3. Click Override Spectral. The Override Spectral 
dialog box opens.

4. Select a new capillary value from the drop-down list.

5. Click OK.

6. Click Save.

7. In “Save the modified spectral calibration” dialog 
box, enter a new name, then click Save.

8. Select the just saved spectral calibration and click 
Set to activate the spectral calibration.

When a Calibration Fails

If the spectral calibration failed, or if you do not like the appearance of the passed calibration, try one or more of the 
following:

• Verify that the correct chemistry and run module were selected. If not, correct, and then repeat the run.

• Verify the freshness of the reagents used.

Capillary 10 
selected
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If All Capillaries Fail

If all capillaries fail, no spectral profiles are created. However, the raw data can still be viewed.

Viewing the Raw Data for a Failed Spectral 
Calibration

1. In the tree pane of the Data Collection software, click 
GA Instruments > ga3130 or ga3130xl > 

instrument name > Spectral Viewer, then 
review the spectral data.

You observe:

– The window displays data from the previous 
passing spectral calibration.

– This System Status is blinking red.

2.  Click Instrument Status > Event Log to 
view the Event and Errors messages.

3. Click Spectral Viewer.

4. In the Dye Set drop-down list, select the dye set for 
the failed calibration.

5. In the List of Calibrations drop-down list, select the 
failing run. The failing run has a asterisk (*) next to its 
name.

Troubleshooting failing capillaries (continued)

System failure, check 
Event Log
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The window is updated with the information from the 
failed E5 spectral calibration.

6. Use the list of questions below when reviewing the 
raw data to determine the cause of the failure. 

– How many peaks? 

– Any extraneous peaks?

– Peak order?

– Peak shape and signal strength?

– Negative peaks?

– Additional peaks (positive or negative) under the 
main color peak?

Note: It is helpful to magnify the raw data for the review 
process (see THL-TableHeadLeft“Tip: Magnifying the 
Spectral Profile or Raw Data” on page 42).

Raw data

Magnified raw data

Troubleshooting failing capillaries (continued)

Raw data

Failed
capillaries

No spectral
profile



Chapter 3 Troubleshooting
Plate Linking

Applied Biosystems 3130/3130xl Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide 47

Notes

3

Plate Linking

Troubleshooting plate linking

Plate does not link. Spatial calibration was not performed. 1. Perform a spatial calibration.

2. Relink the plate(s) in the Run 
Scheduler.

The plates in the Run Scheduler 
were linked, but now are 
unlinked.

A wizard was used after linking a plate, but 
before starting a run – automatically unlinking 
the plate.

Relink the plate(s) in the Run 
Scheduler.
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The plate links, but System 
Status changes from green to 
red.

A different length capillary array was installed, 
and the appropriate active spectral calibration 
was not selected or does not exists. 

1. View the error messages in the 
Event Log.

2. In the Spectral Calibration Viewer, 
set the active spectral calibration 
for the dye set and array length.

3. If one does not exist, create a new 
spectral calibration for the dye set 
and array length you are using, 
then set it as the active spectral 
calibration.

4. Relink the plate(s) in the Run 
Scheduler.

The capillary array length and/or polymer type 
selected in the Instrument Protocol does not 
match capillary array length and/or polymer 
type stored in the database.

Correct the Instrument Protocol,
or 

1. Use the wizards to update the 
information in the database.

2. Set or create an active spectral 
calibration.

3. Relink the plate.

The database and/or drive E is full. To check the available space:

1. View the error messages in the 
Event Log.

2. Proceed to H1a-
Heading1_anywhere“Hard Disk 
and Database Status” on page 30.

3. Make more space.

4. Relink the plate(s) in the Run 
Scheduler.

Troubleshooting plate linking (continued)
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Run Performance

Troubleshooting using Run validation tests

Run Validation

All validation tests must pass before the run starts.

The Test checks... Look For Corrective Action

The capillary array length and/or polymer 
type in the Instrument Protocol against 
the capillary array length and/or polymer 
type in the database

1. System Status changes from 
green to red.

2. View the error messages in 
the Event Log.

Correct the Instrument Protocol,
or 

1. Use the wizards to update the 
information in the database.

2. Set or create an active spectral 
calibration.

3. Relink the plate, then click .

The available space in the database and 
drive E

To correct:

1. See H1a-Heading1_anywhere“Hard 
Disk and Database Status” on page 30 
to access information on databases 
and sample data storage.

2. Make more space.

3. Click .

If a different length capillary array was 
installed, and the appropriate active 
spectral calibration was not selected or 
does not exist. 

To correct:

1. In the Spectral Calibration Viewer, set 
the active spectral calibration for the 
dye set and array length you are using.

2. If one does not exist, create a new 
spectral calibration for the dye set and 
array length you are using, then set as 
the active spectral calibration.

3. Click .
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Troubleshooting run performance

Observation Possible Cause Recommended Action

No peaks in any sample file. Bubbles in the system.

No sample injection.

Visually inspect the polymer block for bubbles.

Remove bubbles using the Bubble Remove 
Wizard. 

1. If bubbles persist, select the Water Wash 
Wizard.

2. If necessary, select the Replenish Polymer 
Wizard to install fresh polymer.

CHEMICAL HAZARD. 
POP-4, POP-6 and POP-7 polymer causes 
eye, skin, and respiratory tract irritation. 
Read the MSDS, and follow the handling 
instructions. Wear appropriate protective 
eyewear, clothing, and gloves.

Possible contaminant in the polymer 
path.

Select the Water Wash Wizard. 

Possible contaminant or crystal deposits 
in the polymer bottle.

Bring the polymer to room temperature, swirl to 
dissolve any deposits.

Replace the polymer if it has expired.

CHEMICAL HAZARD. POP-4, 
POP-6 and POP-7 polymer cause eye, skin, and 
respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Green Start button is 
disabled.

Communication failure between the Data 
Collection Software and Sequencing 
Instrument.

Install Software Patch CE_DC_300-002. To 
download the patch, go to 
http://www.appliedbiosystems.com, then click 
the link for Support, then Software Downloads, 
then Applied Biosystems 3130/3130xl Genetic 
Analyzer, then Updaters and Patches. To install 
the patch, follow the instructions in the Read 
Me pdf file.

WARNING!

WARNING!
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No signal. Autosampler calibration is not optimal. Check the injection with 20-µL samples. 

• If the 20-µL samples have adequate signal 
level, then recalibrate the autosampler using 
the Autosampler Calibration Wizard. 

IMPORTANT! You must power on the 
instrument to use the new values.

• If the 20-µL samples still have no signal then 
check the other possible causes.

Bubble at bottom of sample tube. Centrifuge the sample tubes.

Bent capillary array tips. Replace the capillary array and recalibrate the 
autosampler using the Autosampler Calibration 
Wizard.

Failed reaction. Repeat reaction.

Cracked or broken capillary Visually inspect the capillary array, including the 
detector window area for signs of breakage.

No signal. Blocked capillary Refill capillary array. You may have to install a 
fresh array or consider that capillary non-usable 
for purposes of planning your runs.

Signal too high. Sample concentration is too high. Dilute the sample.

Decrease the injection time.

Too much DNA added to the reaction, 
resulting in uneven signal distribution.

Optimize reaction conditions.

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action
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Low signal strength. Degraded formamide. Use a fresh aliquot of Hi-Di formamide.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and respiratory 
tract irritation. It is a possible reproductive and 
birth defect hazard. Read the MSDS, and follow 
the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

Pipetting error; not enough sample. Increase the amount of DNA added. 

Recalibrate the pipets.

Sample has high salt concentration. Dilute with distilled or deionized water.

Desalt using a column purification method.

Insufficient mixing. Vortex the sample thoroughly, and then 
centrifuge the tube to condense the sample to 
the bottom of the tube.

Autosampler out of calibration. Check the injection with 20-µL samples. If the 
20-µL samples have adequate signal levels, 
then recalibrate the autosampler using the 
Autosampler Calibration Wizard. 

Power off and on the instrument to use the new 
calibration values.

Weak amplification of DNA. Reamplify the DNA.

Check DNA quality.

Elevated baseline. Possible contaminant in the polymer 
path.

Select the Water Wash Wizard. 

Possible contaminant or crystal deposits 
in the polymer.

Bring the polymer to room temperature, swirl to 
dissolve any deposits.

Replace the polymer if it has expired.

CHEMICAL HAZARD.POP-4, 
POP-6 and POP-7 polymer cause eye, skin, and 
respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear 
appropriate protective eyewear, clothing, and 
gloves.

Poor spectral calibration. Perform new spectral calibration.

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action

WARNING!
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Loss of resolution. Too much sample injected. Dilute the sample and re-inject.

Poor quality water. Use distilled or deionized water.

Poor quality or dilute running buffer. Prepare fresh running buffer from 10X 3130 
buffer with EDTA.

CHEMICAL HAZARD. 10X 
Genetic Analyzer Buffer with EDTA may cause 
eye, skin, and respiratory tract irritation. Read 
the MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, 
and gloves.

Degraded polymer. Use a fresh supply of polymer.

Capillary array used for more than 100 
injections.

Replace with new capillary array.

Degraded formamide. Prepare fresh Hi-Di formamide and re-prepare 
samples.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and respiratory 
tract irritation. It is a possible reproductive and 
birth defect hazard. Read the MSDS, and follow 
the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

High salt concentration in samples. Use a recommended protocol for salt removal. 
Dilute salts with water.

Poor resolution in some 
capillaries.

Insufficient filling of capillary array. Refill the capillary array and look for polymer 
leakage. If problem persists contact Technical 
Support.

Re-inject the same samples.

Poor quality samples. Check the sample preparation.

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action
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No current. Water placed in buffer reservoir 
position 1.

Replace with fresh 1X running buffer.

Not enough buffer in anode reservoir. Add buffer up to the fill line. 

Buffer too dilute. Prepare 1X running buffer.

Add 3 mL 10X Genetic Analyzer Buffer with 
EDTA to 27 mL deionized water.

CHEMICAL HAZARD. 10X 
Genetic Analyzer Buffer with EDTA may cause 
eye, skin, and respiratory tract irritation. Read 
the MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, 
and gloves.

Bubble(s) present in the lower polymer 
block and/or the array and/or tubing.

Pause run and inspect for bubbles hidden in the 
tubing connectors.

Select the Bubble Remove Wizard to remove 
the bubbles.

Elevated current. Degraded polymer. Open fresh supply of polymer and use 
Replenish Polymer Wizard.

Incorrect buffer dilution. Prepare 1X running buffer.

Add 3 mL 10X Genetic Analyzer Buffer with 
EDTA to 27 mL deionized water.

CHEMICAL HAZARD. 10X 
Genetic Analyzer Buffer with EDTA may cause 
eye, skin, and respiratory tract irritation. Read 
the MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, 
and gloves.

Arcing in the lower polymer block. Inspect the lower polymer block for 
discoloration or damage. Replace the lower 
polymer block if necessary. 

Fluctuating current. Bubble in polymer block. Pause run and inspect for bubbles hidden in the 
tubing connectors.

Select Bubble Remove Wizard to remove the 
bubbles.

A slow leak may be present in the 
system.

Check polymer blocks for leaks. Tighten all 
fittings.

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action
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Incorrect buffer concentration. Prepare 1X running buffer.

Add 3 mL 10X Genetic Analyzer Buffer with 
EDTA to 27 mL deionized water.

CHEMICAL HAZARD. 10X 
Genetic Analyzer Buffer with EDTA may cause 
eye, skin, and respiratory tract irritation. Read 
the MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, 
and gloves.

Not enough buffer in anode reservoir. Add buffer up to the fill line. 

Arcing. Check for moisture in and around the septa, the 
reservoirs, the oven, and the autosampler.

Poor performance of 
capillary array used for 
fewer than 100 runs.

Poor quality samples, possible cleanup 
problems.

Desalt samples using a recommended 
purification protocol.

Poor quality formamide. Prepare fresh Hi-Di formamide and re-prepare 
samples.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and respiratory 
tract irritation. It is a possible reproductive and 
birth defect hazard. Read the MSDS, and follow 
the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

Incorrect buffer. Use 10X Genetic Analyzer Buffer with EDTA to 
prepare 1X running buffer.

CHEMICAL HAZARD. 10X 
Genetic Analyzer Buffer with EDTA may cause 
eye, skin, and respiratory tract irritation. Read 
the MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, 
and gloves.

Migration time becomes 
progressively slower.

Leak in system. Tighten the tubing connectors and array knob.

Improper filling of the system with 
polymer.

Polymer delivery pump may need to be 
serviced. Call a service representative.

Expired polymer. Check expiration of polymer. If necessary, 
change the lot.

Migration time becomes 
progressively faster.

Water in polymer system, resulting in 
diluted polymer.

Use Bubble Remove Wizard to add polymer to 
system.

Buffer valve leakage Check the buffer valve pin and see if it closes 
correctly.

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action
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Extra peaks in the 
electropherogram.

Data off scale. Dilute the sample and re-inject the sample.

Possible contaminant in sample. Re-amplify the DNA.

Sample renaturation. Heat-denature the sample in good-quality 
formamide and immediately place on ice.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and respiratory 
tract irritation. It is a possible reproductive and 
birth defect hazard. Read the MSDS, and follow 
the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

Peaks exhibit a shoulder in 
GeneMapper software 
applications.

Sample renaturation. Heat-denature the sample in good-quality 
formamide and immediately place on ice.

CHEMICAL HAZARD. 
Formamide causes eye, skin, and respiratory 
tract irritation. It is a possible reproductive and 
birth defect hazard. Read the MSDS, and follow 
the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

Error message, “Leak 
detected” appears. The run 
aborts.

Bubbles in the polymer system. Select the Bubble Remove Wizard to clear 
bubbles.

Leak in the polymer system. Check for evidence of leaks. Tighten the tubing 
connectors and array knob.

Buffer valve leakage. Check the buffer valve pin and see if it closes 
correctly.

Buffer jar overflows very 
quickly with polymer.

Bubbles in the polymer path. 
(Overuse of the Bubble Remove Wizard)

Check for bubbles and remove if present. 

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action
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Detection cell comes out 
while replacing the capillary 
array. Replacing the cell in 
the correct orientation is 
difficult.

Improperly placed detection cell. Loosen the array knob. Close the detection 
block door. Retighten the array knob.

Detection cell stuck. It is 
difficult to remove when 
changing the capillary array.

To loosen the detection cell:

1. Undo the array knob and pull the polymer 
block towards you to first notch.

2. Hold both sides of the capillary array around 
the detection cell area, and apply gentle 
pressure equally on both sides.

3. Remove the capillary comb from the holder 
in oven.

4. Release.

Troubleshooting run performance (continued)

Observation Possible Cause Recommended Action
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Chapter 4

4

Data Collection Software
Advanced Functions

Overview This chapter covers the following topics:

Customizing Run Modules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Run Priority Scheduling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Edit > Fill Down Special Option for Plate Records . . . . . . . . . . . . . . . . . . . . . . . . . 61
Multi-application (Mixed) Plate Record  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
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Customizing Run Modules
You can modify default run modules to suit your 
particular needs. 

1. Click GA Instruments > ga3130xl or 
ga3130 > instrument name > Module 
Manager. 

2. Click . The Run Module Editor dialog 
box opens.

3. Complete the Run Module Editor dialog box:
a. Enter a name for your new module.
b. In the Type drop-down list, select the type 

of module (Regular, Spatial or Spectral).
c. In the Template drop-down list, select a 

template module as a basis for the new 
module.

Note: You cannot edit a default module installed 
with the 3130/3130xl Genetic Analyzer 
Data Collection software.

4. Optional: Enter a description of your new run 
module.

3d

3c

3b

3f

3e

3a
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5. Change to the desired module parameters using allowable ranges shown in the table 
below:

6. Click OK.

Name Range Comment

Oven_Temperature 18-65 C Temperature setting for main oven 
throughout run.

Poly_Fill_Vol variable to 38000 
counts

Check for amount of polymer 
available in the PDP.

Current_Stability 0 –2000 µAmp Maximum current variation during 
electrophoresis

PreRun_Voltage 0-15 kV Pre run voltage setting before 
sample injection.

PreRun Time 1-1000 sec Prerun voltage time.

Injection_Voltage 0-15 kV Injection voltage setting for sample 
injection.

Injection_Time 1-600 sec Sample injection time.

Run_Voltage 0-15 kV Final run voltage.

Voltage_Number_Of_S
teps

0-100 steps Number of voltage ramp steps to 
reach Run_Voltage. Applied 
Biosystems recommends that you 
do not change this value.

Voltage_Step_Interval 0-60 sec Dwell time at each voltage ramp 
step. Applied Biosystems 
recommends that you do not change 
this value.

Data_Delay_Time 1-3600 sec Time from the start of separation to 
the start of data collection.

Run_Time 300-14000 sec Duration data is collected after 
Data_Delay_Time.
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Run Priority Scheduling

Priority Values The user-definable run priority scheduling function allows you to schedule runs in 
custom order providing flexibility when scheduling runs.

A default value of 100 is assigned to each sample in the plate record. Changing the value 
to a smaller number causes that set of 16 or 4 samples to run before the others in the 
injection list. 

Scheduling Examples 

Default Run
Scheduling

Using a 96-well Plate and 16 Capillary Array

In this example, 100 is the priority value for all samples in the plate record and the 
default run priority schedule is used (see table below). Samples A07�H08 called out on 
the plate record, correspond to Run 4 as displayed in the Run Scheduler > Run View 
window.

Default run priority schedule, samples in wells A07–H08 are scheduled as Run 4

Well Numbers Run Number Priority Well Numbers Run Number Priority

A01–H02 1 A07–H08 4

A03–H04 2 A09–H10 5

A05–H06 3 A11–H12 6
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User-definable
Run Priority
Scheduling

In this example, the priority value for sample G07 is arbitrarily set to 80, a lower number 
than 100, forcing the software to give the sample a higher run priority. All other samples 
remain 100. Sample well G07 is contained in the A07�H08 injection set. All 16 samples 
now correspond to Run 1, as displayed in the Run Scheduler > Run View window. 

The table below shows the change in the run priority schedule.

User defined run priority schedule, samples in wells A07–H08 are scheduled as 
Run 1 due to G07 sample assigned a value of 80

Well Numbers Run Number Priority

A07–H08 1

A01–H02 2

A03–H04 3

A05–H06 4

A09–H10 5

A11–H12 6
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The rest of the samples are run after the samples in wells A07�H08. Samples in wells 
A01�H02 are now scheduled as Run 2.

User defined run priority schedule, samples in wells A01–H02 are now scheduled as 
Run 2
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Edit > Fill Down Special Option for Plate Records

Using Fill Down Special Option

Based on your plate type (96- or 384-well) and 
capillary array (16 or 4 capillaries), the software 
automatically fills in the appropriate well positions 
for a single run.

The Fill Down Special option works with all plate 
records (Spectral, Sequencing Analysis, SeqScape® 
software, GeneMapper®software, and Mixed plates). 

Creating and Completing the Plate Record

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130 or 
ga3130xl > Plate Manager.

2. Click  to open the New Plate Dialog 
dialog box.

3. Complete the information in the New Plate 
Dialog box, then click  to open the Plate 
Editor.

4. Complete the columns for a single well position.

Note: You can start at any well position, the 
software automatically fills up or down based on 
the default run scheduling patterns. 

5. Highlight the entire row.
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6. Select Edit > Fill Down Special.

7. Click  to save the plate record.
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Examples of Fill
Down Special

Examples of completed plate records and run scheduling for the 3130 and 3130xl 
instruments, and 96- and 384-well plates are shown below.

96-well plate on a 3130xl genetic analyzer

384-well plate on a 3130xl genetic analyzer
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96-well plate on a 3130 genetic analyzer

384-well plate on a 3130 genetic analyzer
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Multi-application (Mixed) Plate Record

Protocols for a
Mixed Plate

Record

To run a mixed plate containing sequencing, SeqScape software and/or fragment 
analysis samples, the following files are required:

� Sequencing analysis 
� Results Group
� Instrument Protocol
� Analysis Protocol

� SeqScape software analysis 
� Results Group
� Instrument Protocol
� Analysis Protocol
� Files created in SeqScape software

� Fragment analysis
� Results Group
� Instrument Protocol
� Files created in GeneMapper software

Creating Spectral
Calibrations

For every dye set and capillary array length combination you use, a separate spectral 
calibration must be created.

Setting the Active
Spectral

Calibration

If you changed the capillary array length to run multi-application samples, you must set 
the active spectral calibration for each dye set used. See the Applied Biosystems 
3130/3130xl Genetic Analyzers Getting Started Guide on how to set the active 
calibrations once calibrations are performed for each dye set on each capillary length.
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Creating and Completing a Mixed Plate 
Record

1. In the tree pane of the Data Collection software, 
click GA Instruments > ga3130 or 
ga3130xl > Plate Manager.

2. Click .
The New Plate Dialog dialog box opens.

3. Complete the information in the New Plate 
Dialog:

a. Type a name for the plate.
b. Type a description for the plate (optional).
c. Select Mixed in the Application drop-down 

list.
d. Select 96-well or 384-well in the Plate Type 

drop-down list.
e. Type a name for the owner and operator.
f. Click . 

The Integrated Plate Dialog box opens.

3a

3b

3c

3d

3e

3f
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4. In the Set Application pane:
a. On the plate map, click a well position. The 

run of 16 or 4 capillaries is outlined.
b. In the Application drop-down list select the 

appropriate application.

c. Repeat the process for additional samples 
and applications.

4b

4a
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5. Create the Sequencing sample sheets (plate 
record).

a. On the plate map, click a well position that 
represents a sequencing sample.

b. Click Sample Sheet. 

The Sequencing Analysis Plate editor 
opens.

c. Complete the plate record.

Note: The well column contains only those 
wells that were designated as sequencing 
samples on the plate map.

d. Click . You are automatically returned 
to the Integrated Plate dialog box.

5b

5a
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6. Create the GeneMapper software sample sheet 
(plate record).

a. On the plate map, click a well position that 
represents a GeneMapper software sample.

b. Click Sample Sheet to open the 
GeneMapper software Plate editor.

c. Complete the plate record. 
d. Click OK. 

7. Create the SeqScape software sample sheet 
(plate record).

a. On the plate map, click a well position that 
represents a sequencing sample.

b. Click Sample Sheet to open the SeqScape 
software Plate editor.

c. Complete the plate record. 
d. Click OK. 

8. Click Done.

6b

6a
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Chapter 5

5

Reference Tables

Overview This chapter covers the following topics:

Sequencing Summary Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Fragment Analysis Summary Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
Run Modules  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
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Sequencing Summary Tables

Performance
Table

Sequencing Resolution Performance and Specification

 Type of Run
Capillary 
Length

(cm)

Polymer

Type
Module

Run 
Time 
(min)

24 hr Throughput 
(number of 
samples) KB™ 

Basecaller 
QV20 LORa b3130

Genetic 
Analyzer

3130xl

Genetic 
Analyzer

Ultra rapid 36 POP-4 UltraSeq36_POP4 40 144 576 400 

POP-7 UltraSeq36_POP7 35 164 656 500

Rapid 36 POP-6 RapidSeq36_POP6 60 96 384 500 

POP-7 RapidSeq36_POP7 96 384 600

Fast 50 POP-7 FastSeq50_POP7 60 96 384 700

Standard 50 POP-4 StdSeq50_POP4 100 56 224 600 

POP-6 StdSeq50_POP6 150 36 144 600 

POP-7 StdSeq50_POP7 120 48 192 850

Long read 80 POP-4 LongSeq80_POP4 210 24 96 700

POP-7 LongSeq80_POP7 170 32 128 950

a Length of Read (LOR) is the usable range of high-quality or high-accuracy bases determined by Quality Values (QV) generated 
by KB Basecaller v1.2. The LOR is determined by using a sliding window of 20 bases, which has an average QV > 20.

b 98.5% basecalling accuracy, less than 2% Ns.
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Calibration
Standard Table

Sequencing Dye Sets, Calibration Standards, and Chemistry File

Dye Set and Run
Modules

Sequencing Kits, Dye Sets, Polymer Type and Run Modules

Sequencing Chemistry Dye Set Spectral Calibration Standard Chemistry File

• BigDye® Terminator v3.1 Cycle 
Sequencing Kit

• ABI PRISM® dGTP BigDye® 
Terminator v 3.0 Cycle Sequencing 
Ready Reaction Kita

Z_BigDyeV3 BigDye® v3.1 Matrix Standards Matrix Standard

BigDye® v3.1 Terminator 
Sequencing Standard

Sequence Standard

• BigDye® Terminator v1.1 Cycle 
Sequencing Kit

• ABI PRISM® BigDye® Primer Cycle 
Sequencing Kits

• ABI PRISM® dGTP BigDye® 
Terminator Cycle Sequencing Kita

E_BigDyeV1 DS-01 Matrix Standards Matrix Standard

BigDye® v1.1 Terminator 
Sequencing Standard

Sequence Standard

ABI PRISM® dRhodamine Dye 
Terminator Cycle Sequencing Ready 
Reaction Kit

dRhodamine Matrix Standards Kit Matrix Standard

a dGTP kits are not supported on capillary electrophoresis instruments due to compressions on certain sequence context regions; you can 
run the kits if you do not care about the compression issues.

POP-4 
Polymer

POP-6 
Polymer POP-7 Polymer

Sequencing Chemistry Dye Set

U
lt

ra
S

eq
36

S
td

S
eq

50

Lo
ng

S
eq

80

R
ap

id
S

eq
36

S
td

S
eq

50

U
lt
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S

eq
36

R
ap

id
S

eq
36

Fa
st

S
eq

50

S
td

S
eq

50

Lo
ng

S
eq

80

BigDye® Terminator v3.1 Cycle Sequencing Kit Z_BigDye
V3

✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

ABI PRISM® dGTP BigDye® Terminator v3.0 
Cycle Sequencing Ready Reaction Kit

— — — — — — — — — —

BigDye® Terminator v1.1 Cycle Sequencing Kit E_BigDye
V1

✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

ABI PRISM® dGTP BigDye® Terminator Cycle 
Sequencing Kit*

— — — — — — — — — —

ABI PRISM® dRhodamine Dye Terminator 
Cycle Sequencing Ready Reaction Kit

✓ ✓ ✓ ✓ ✓ — — — — —

ABI PRISM® BigDye® Primer Cycle Sequencing 
Kits

— — — ✓ ✓ — — — — —
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Table

Basecaller and DyeSet/Primer Files Using KB Basecalling

3130/3130xl Genetic Analyzer Basecaller and DyeSet/Primer Files Used with BigDye® Terminator Chemistry 
and KB Basecalling

DNA Sequencing 
Chemistry Polymer KB Basecalling Run 

Module DyeSet/Primer Basecaller

BigDye® Terminator v1.1 
Cycle Sequencing Kit

POP-4™ UltraSeq36_POP4 KB_3130_POP4_BDTv1.mob KB.bcp

StdSeq50_POP4

LongSeq80_POP4

POP-6™ RapidSeq36_POP6 KB_3130_POP6_BDTv1.mob

StdSeq50_POP6

POP-7™ UltraSeq36_POP7 KB_3130_POP7_BDTv1.mob

RapidSeq36_POP7

FastSeq50_POP7

StdSeq50_POP7

LongSeq80_POP7

BigDye® Terminator v3.1 
Cycle Sequencing Kit

POP-4 UltraSeq36_POP4 KB_3130_POP4_BDTv3_.mob

StdSeq50_POP4

LongSeq80_POP4

POP-6 RapidSeq36_POP6 KB_3130_POP6_BDTv3.mob

StdSeq50_POP6

POP-7 UltraSeq36_POP7 KB_3130_POP7_BDTv3.mob

RapidSeq36_POP7

FastSeq50_POP7

StdSeq50_POP7

LongSeq80_POP7
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ABI Basecaller
Table and Dye

Terminator Kits

Basecaller and DyeSet/Primer Files Using ABI Basecalling with Dye Terminator 
Chemistry

Basecaller and DyeSet/Primer Files Used with BigDye® Terminator Chemistry and ABI Basecalling

DNA 
Sequencing 
Chemistry

Polymer ABI Basecalling Run 
Module Basecaller DyeSet/Primer

BigDye® 
Terminator v1.1 
Kit

POP-4™ UltraSeq36_POP4 Basecaller-
3130POP4UR.bcp

DT3130POP4LR{BD}v1.
mob

LongSeq80_POP4 Basecaller-
3130POP4_80cmv3.bcp

POP-6™ RapidSeq36_POP6 Basecaller-
3130POP6RRv2.bcp

DT3130POP6{BD}v2.

mob
StdSeq50_POP6 Basecaller-

3130POP6SR.bcp

BigDye 
Terminator v3.1 
Cycle 
Sequencing Kit

POP-4 UltraSeq36_POP4 Basecaller-
3130POP4UR.bcp

DT3130POP4{BDv3}v1.
mob

LongSeq80_POP4 Basecaller-
3130POP4_80cmv3.bcp

POP-6 RapidSeq36_POP6 Basecaller-
3130POP6RRv2.bcp

DT3130POP6{BDv3}v1.
mob

StdSeq50_POP6 Basecaller-
3130POP6SRv2.bcp

ABI PRISM® 
dRhodamine 
Dye Terminator 
Cycle 
Sequencing 
Ready Reaction 
Kit

POP-4 UltraSeq36_POP4 Basecaller-
3130APOP4UR.bcp

DT3130POP4{dRhod}v2
.mob

LongSeq80_POP4 Basecaller-
3130POP4_80cmv3.bcp

POP-6 RapidSeq36_POP6 Basecaller-
3130POP6RRv2.bcp

DT3130POP6{dRhod}v2
.mob

StdSeq50_POP6 Basecaller-
3130POP6SR.bcp
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ABI Basecaller
Table and Dye

Primer Kits

Basecaller and DyeSet/Primer Files Using ABI Basecalling with Dye Primer 
Chemistry 

3130xl Basecaller and DyeSet/Primer Files Used for Dye Primer Chemistry

DNA 
Sequencing 
Chemistry

Polymer ABI Basecalling Run 
Module Basecaller DyeSet/Primer

ABI PRISM® 
BigDye® Primer 
Cycle 
Sequencing Kit

POP-6 RapidSeq36_POP6 Basecaller-
3130POP6RRv2.bcp

DP3130POP6{BD
-21M13}v1.mob

StdSeq50_POP6 Basecaller-
3130POP6SR.bcp

DP3130POP6{BD
-21M13Rev}v1.mob
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Fragment Analysis Summary Tables

Performance
Table

Fragment Analysis Resolution Performance and Specifications 

Run Modules
Capillary
Length

(cm)

Polymer

Type

Run 
Time 
(min)

24 hr Throughput (GTa)
Resolution

(bp)
Specification 

(SD)b3130 
Analyzer

3130xl 
Analyzer

High Throughput, Small Size Fragment Analysis

FragmentAnalysis22
_POP4

22 POP-4 20 5,760 23,040 400 0.15

SNP22_POP4 22 20 5,760 23,040 120 0.50

Standard Fragment Analysis

FragmentAnalysis36
_POP4

36 POP-4 45 2,560 10,240 500 0.15

HIDFragmentAnalysis
36_POP4

45 2,560 10,240 500 0.15

SNP36_POP4 30 3,840 15,360 120 0.50

FragmentAnalysis36
_POP7

POP-7 35 3,290 13,170 500 0.15

FragmentAnalysis50
_POP4

50 POP-4 65 1,760 7,040 500 0.15

FragmentAnalysis50
_POP6

POP-6 90 1,200 4,800 500 0.15

FragmentAnalysis50
_POP7

POP-7 50 2,300 9,220 500 0.15

a 20 GT (Genotypes)/capillary/injection.
b 1bp resolution at 99.99% accuracy. 
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Kits and Run
Modules

Fragment Analysis Kits, Run Modules, and Dye Sets

Module
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Application/Kit

SNaPshot® Multiplex System E5 E5

Custom oligos D, F, 
G5

D, F, 
G5

D, F, 
G5

D, F, 
G5

D, F, 
G5

D, F, 
G5

Linkage Mapping Set (human) 
v2.5

D, G5 D, G5 D, G5 D, G5 D, G5 D, G5

ABI PRISM® Mouse Mapping Set 
v1.0

D, G5 D, G5 D, G5 D, G5 D, G5 D, G5

4-Dye Stockmarks® kits (bovine 
and canine) 

F

5-Dye Stockmarks® kit (equine) G5

AFLP® kits F

4-Dye AmpFlSTR® kits F

5-Dye AmpFlSTR kits G5
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AmpFlSTR Kit
Table

Kits, Run Modules, and Dye Sets

Calibration
Standards Table

Fragment Analysis Dye Sets, Calibration Standards, and Chemistry File

Kits
HIDFragmentAnalysis
36_POP4

AmpFlSTR COfiler® Kit

AmpFlSTR Profiler Plus® Kit

AmpFlSTR Profiler Plus ID Kit

AmpFlSTR SGM Plus® Kit

Other 4-Dye AmpFlSTR Kits

F

AmpFlSTR SEfiler™ Kit

AmpFlSTR Identifiler® Kit

AmpFlSTR Yfiler™ Kit

Other 5-Dye AmpFlSTR Kits

G5

Fragment Analysis Chemistry Dye Set Spectral Calibration Standard Chemistry File

Custom oligos D DS-30 Matrix Standards Matrix Standard

• ABI PRISM® Mouse Mapping Set v1.0

• Custom oligos

D DS-31 Matrix Standards

• AFLP® kits

• Stockmarks® Kits 4-dye (bovine and 
canine)

• AmpFlSTR® COfiler® Kit

• AmpFlSTR® Profiler Plus® Kit

• AmpFlSTR® Profiler Plus® ID Kit

• AmpFlSTR® SGM Plus® Kit

• Other 4-Dye AmpFlSTR Kits

F DS-32 Matrix Standards

 ABI PRISM® SNaPshot® Multiplex System E5 DS-02 Matrix Standards

• ABI PRISM® Linkage Mapping Set v2.5

• Stockmarks® Kit 5-dye (equine)

• Custom Oligos

• AmpFlSTR® Identifiler® Kit

• AmpFlSTR® SEfiler™ Kit

• AmpFlSTR® Yfiler™ Kit

• Other 5-Dye AmpFlSTR Kits

G5 DS-33 Matrix Standards
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Run Modules

Fragment Analysis Run Modules

See �Fragment Analysis Resolution Performance and Specifications� on page 81 and 
�Kits and Run Modules� on page 82 for available fragment analysis run modules.

Spectral Run Modules

Polymer
Type

Capillary 
Array Length 

(cm)
Run Module

POP-4 22 Spect22_POP4

36 Spect36_POP4

SpectSQ36_POP4

50 Spect50_POP4

80 Spect80_POP4

POP-6 36 Spect36_POP6

50 Spect50_POP6

POP-7 36 Spect36_POP7

50 Spect50_POP7

80 Spect80_POP7

Sequencing Run Modules

Polymer
Capillary 

Array Length 
(cm)

Module

POP-4 36 UltraSeq36_POP4

50 StdSeq50_POP4

80 LongSeq80_POP4

POP-6 36 RapidSeq36_POP6

50 StdSeq50_POP6

POP-7 36 UltraSeq36_POP7

RapidSeq36_POP7

50 FastSeq50_POP7

StdSeq50_POP7

80 LongSeq80_POP7
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Parts List

Capillary Arrays

Reagents and
Standards

Description Part Number

3130 Genetic Analyzer

22- cm capillary array 4333463

36- cm capillary array 4333464

50- cm capillary array 4333466

80- cm capillary array 4333465

3130xl Genetic Analyzer

22- cm capillary array 4319898

36- cm capillary array 4319531

50- cm capillary array 4315930

80- cm capillary array 4319899

Description Part Number

10X Genetic Analyzer Buffer with EDTA 402824

3100/3130 BigDye® Terminator v3.1 Matrix standard 4336974

BigDye® Terminator v3.1 Cycle Sequencing Ready Reaction 
Kit (100 Reactions)

4337455

BigDye® Terminator v3.1 Sequencing Standard 4336935

GeneScan™120 LIZ® Size Standard 4324287

GeneScan 500 LIZ Size Standard 4322682

GeneScan 500 ROX Size Standard 401734

GeneScan HD400 ROX Size Standard 402985

Hi-Di™ Formamide 4311320

Matrix Standard DS-01 4315974

Matrix Standard DS-02 4323014

Matrix Standard DS-30 4345827

Matrix Standard DS-31 4345829

Matrix Standard DS-32 4345831
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Spare Parts

Matrix Standard DS-33 4345833

Performance Optimized Polymer 4 (POP-4™ Polymer) 4316355

Performance Optimized Polymer 6 (POP-6™Polymer) 4352757

Performance Optimized Polymer 7 (POP-7™Polymer) 4352759

Description Part Number

Description Part Number

Array comb holders 628-0164

Array port plug 628-3776

Buffer reservoir, 16 mL 4358351

Buffer/water/waste reservoir 628-0163

Ferrule knob 628-3730

Ferrule sleeves 628-0165

Polymer bottle 4362387

Polymer tubing assembly 628-3732

Septa strip, buffer reservoir 4315932
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Appendix B

Instrument Warranty Information

Computer Configuration
Applied Biosystems supplies or recommends certain configurations of computer 
hardware, software, and peripherals for use with its instrumentation. Applied Biosystems 
reserves the right to decline support for or impose extra charges for supporting 
nonstandard computer configurations or components that have not been supplied or 
recommended by Applied Biosystems. Applied Biosystems also reserves the right to 
require that computer hardware and software be restored to the standard configuration 
prior to providing service or technical support. For systems that have built-in computers 
or processing units, installing unauthorized hardware or software may void the Warranty 
or Service Plan.

Limited Product Warranty

Limited Warranty Applied Biosystems warrants that all standard components of its Applied Biosystems 
3130 and 3130xl Genetic Analyzers will be free of defects in materials and workmanship 
for a period of one (1) year from the date the warranty period begins. 
Applied Biosystems will repair or replace, at its discretion, all defective components 
during this warranty period. After this warranty period, repairs and replacement 
components may be purchased from Applied Biosystems at its published rates. 
Applied Biosystems also provides service agreements for post-warranty coverage. 
Applied Biosystems reserves the right to use new, repaired, or refurbished instruments or 
components for warranty and post-warranty service agreement replacements. Repair or 
replacement of products or components that are under warranty does not extend the 
original warranty period.

Applied Biosystems warrants that all optional accessories supplied with its 
Applied Biosystems 3130 and 3130xl Genetic Analyzers, such as peripherals, printers, 
and special monitors, will be free of defects in materials and workmanship for a period 
of ninety (90) days from the date the warranty begins. Applied Biosystems will repair or 
replace, at its discretion, defective accessories during this warranty period. After this 
warranty period, Applied Biosystems will pass on to the buyer, to the extent that it is 
permitted to do so, the warranty of the original manufacturer for such accessories.

With the exception of consumable and maintenance items, replaceable products or 
components used on or in the instrument are themselves warranted to be free of defects 
in materials and workmanship for a period of ninety (90) days.
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Applied Biosystems warrants that chemicals and other consumable products will be free 
of defects in materials and workmanship when received by the buyer, but not thereafter, 
unless otherwise specified in documentation accompanying the product.

Applied Biosystems warrants that for a period of ninety (90) days from the date the 
warranty period begins, the tapes, diskettes, or other media bearing the operating 
software of the product, if any, will be free of defects in materials and workmanship 
under normal use. If there is a defect in the media covered by the above warranty and the 
media is returned to Applied Biosystems within the ninety (90) day warranty period, 
Applied Biosystems will replace the defective media.

Applied Biosystems does not warrant that the operation of the instrument or its operating 
software will be uninterrupted or error free. 

Warranty Period
Effective Date

Any applicable warranty period under these sections begins on the earlier of the date of 
installation or ninety (90) days from the date of shipment for hardware and software 
installed by Applied Biosystems personnel. For all hardware and software installed by 
the buyer or anyone other than Applied Biosystems, and for all other products, the 
applicable warranty period begins the date the product is delivered to the buyer.

Warranty Claims Warranty claims must be made within the applicable warranty period, or, for chemicals 
or other consumable products, within thirty (30) days after receipt by the buyer.

Warranty
Exceptions

The above warranties do not apply to defects resulting from misuse, neglect, or accident, 
including without limitation: operation with incompatible solvents or samples in the 
system; operation outside of the environmental or use specifications or not in 
conformance with the instructions for the instrument system, software, or accessories; 
improper or inadequate maintenance by the user; installation of software or interfacing, 
or use in combination with software or products, not supplied or authorized by 
Applied Biosystems; and modification or repair of the product not authorized by 
Applied Biosystems.

THE FOREGOING PROVISIONS SET FORTH Applied Biosystems’ SOLE AND 
EXCLUSIVE REPRESENTATIONS, WARRANTIES, AND OBLIGATIONS WITH 
RESPECT TO ITS PRODUCTS, AND APPLIED BIOSYSTEMS MAKES NO OTHER 
WARRANTY OF ANY KIND WHATSOEVER, EXPRESSED OR IMPLIED, 
INCLUDING WITHOUT LIMITATION, WARRANTIES OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE, WHETHER ARISING FROM A 
STATUTE OR OTHERWISE IN LAW OR FROM A COURSE OF DEALING OR 
USAGE OF TRADE, ALL OF WHICH ARE EXPRESSLY DISCLAIMED.

Warranty
Limitations

THE REMEDIES PROVIDED HEREIN ARE THE BUYER'S SOLE AND 
EXCLUSIVE REMEDIES. WITHOUT LIMITING THE GENERALITY OF THE 
FOREGOING, IN NO EVENT SHALL APPLIED BIOSYSTEMS BE LIABLE, 
WHETHER IN CONTRACT, TORT, WARRANTY, OR UNDER ANY STATUTE 
(INCLUDING WITHOUT LIMITATION, ANY TRADE PRACTICE, UNFAIR 
COMPETITION, OR OTHER STATUTE OF SIMILAR IMPORT) OR ON ANY 
OTHER BASIS, FOR DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, MULTIPLE, 
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CONSEQUENTIAL, OR SPECIAL DAMAGES SUSTAINED BY THE BUYER OR 
ANY OTHER PERSON OR ENTITY, WHETHER OR NOT FORESEEABLE AND 
WHETHER OR NOT APPLIED BIOSYSTEMS IS ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES, INCLUDING WITHOUT LIMITATION, DAMAGES 
ARISING FROM OR RELATED TO LOSS OF USE, LOSS OF DATA, FAILURE OR 
INTERRUPTION IN THE OPERATION OF ANY EQUIPMENT OR SOFTWARE, 
DELAY IN REPAIR OR REPLACEMENT, OR FOR LOSS OF REVENUE OR 
PROFITS, LOSS OF GOOD WILL, LOSS OF BUSINESS, OR OTHER FINANCIAL 
LOSS OR PERSONAL INJURY OR PROPERTY DAMAGE.

NO AGENT, EMPLOYEE, OR REPRESENTATIVE OF Applied Biosystems HAS 
ANY AUTHORITY TO MODIFY THE TERMS OF THIS LIMITED WARRANTY 
STATEMENT OR TO BIND APPLIED BIOSYSTEMS TO ANY AFFIRMATION, 
REPRESENTATION, OR WARRANTY CONCERNING THE PRODUCT THAT IS 
NOT CONTAINED IN THIS LIMITED WARRANTY STATEMENT, AND ANY 
SUCH MODIFICATION, AFFIRMATION, REPRESENTATION, OR WARRANTY 
MADE BY ANY AGENT, EMPLOYEE, OR REPRESENTATIVE OF 
APPLIED BIOSYSTEMS WILL NOT BE BINDING ON APPLIED BIOSYSTEMS, 
UNLESS IN A WRITING SIGNED BY AN EXECUTIVE OFFICER OF 
APPLIED BIOSYSTEMS.

THIS WARRANTY IS LIMITED TO THE BUYER OF THE PRODUCT FROM 
APPLIED BIOSYSTEMS AND IS NOT TRANSFERABLE.

Some countries or jurisdictions limit the scope of or preclude limitations or exclusion of 
warranties, of liability, such as liability for gross negligence or wilful misconduct, or of 
remedies or damages, as or to the extent set forth above. In such countries and 
jurisdictions, the limitation or exclusion of warranties, liability, remedies or damages set 
forth above shall apply to the fullest extent permitted by law, and shall not apply to the 
extent prohibited by law.
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Damages, Claims, and Returns

Damages If shipping damage to the product is discovered, contact the shipping carrier and request 
inspection by a local agent. Secure a written report of the findings to support any claim. 
Do not return damaged goods to Applied Biosystems without first securing an inspection 
report and contacting Applied Biosystems Technical Support for a Return Authorization 
(RA) number.

Claims After a damage inspection report is received by Applied Biosystems, 
Applied Biosystems will process the claim unless other instructions are provided.

Returns Do not return any material without prior notification and authorization. 

If for any reason it becomes necessary to return material to Applied Biosystems, contact 
Applied Biosystems Technical Support or your nearest Applied Biosystems subsidiary 
or distributor for a return authorization (RA) number and forwarding address. Place the 
RA number in a prominent location on the outside of the shipping container, and return 
the material to the address designated by the Applied Biosystems representative.
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Index

Numerics
3130 basecaller and DyeSet/Primer files 79, 80

3130calib.ini 40

A
ABI PRISM® BigDye® Primer Cycle Sequencing Kits

table, dye sets and standards 77
ABI PRISM® dGTP BigDye® Terminator Cycle 

Sequencing Ready Reaction Kit, table of dye 
set and standards 77

ABI PRISM® dGTP BigDye® Terminator v 3.0 Cycle 
Sequencing Ready Reaction Kit

table of dye set and standards 77
ABI PRISM® dRhodamine Terminator Cycle Sequencing 

Kit
table of information 77

account password, see password

AmpFlSTR kits
matrix standard 83
table of dye sets, filter, modules 83

array port, illustration of 2

autosampler 10
calibrating 23
controlling. See manual control commands
non-optimal calibration 51
will not move forward 38

Autosampler Calibration Wizard
calibration, autosampler 23

B
basecaller and DyeSet/Primer files 78

basecaller files 78, 79, 80

basecaller, and ABI basecalling 79

BigDye® Terminator chemistry, information tables 78

BigDye® Terminator v3.1 Cycle Sequencing Kit
table, dye set and standard 77

Bubble Remove Wizard 22

bubbles, clearing 22

buffer fill-line 2

buffer jar, illustration of 2

buffer valve pin, illustration of 2

buffer, making and storing 15

C
calibration standards

types, fragment analysis 83
capillary array

care 20
failing 44
illustration of 2
manually filling 8
poor performance 55
storing off the instrument 21
storing on the instrument 21
when to change 18

capillary array knob and tip, illustration of 2

cathode bar 18

CD, creating a data 31

Change Polymer Type Wizard 17

check valve
diagram of 2

claims, processing 90

cleaning instrument, routine 5

Cleanup Database utility 34

communication cable
must be original 40
replacing 40

computer
checking hard drive space 30
configuration requirement 87
frozen 38
technical support for altered configuration 87

current, troubleshooting 54

customizing 60

D
damage, reporting 90

damaged items, returning 90

data
archiving 31
none in capillaries 50

Data Collection software
will not launch 38

Data Explorer software
3130calib.ini file 40
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database
checking disk space 30
deleting records 34
error messages 28

defragmenting hard drive 33

double-tapered ferrule, illustration of 2

drive
checking available space 28
cleaning 29
defragmenting 33

dye primer chemistry, information table 80

dye set
fragment analysis 83

Dye Terminator chemistry, files 78, 79

DyeSet/Primer files 78, 79, 80

E
E dye set, sequencing kit table 77

electrode, illustration of 2

elevated baseline 52

error messages 28
viewing 29

event log, accessing 29

event viewer, blank 38

F
failing capillaries 44

fill down special option 65

filter set
fragment analysis 82

flushing, water trap 13

fragment analysis
filter set 82
kit types 82
run modules 84

H
hard drive space, checking 30

hard drive, defragmenting 33

I
Install Array Wizard 19

instrument
cleaning, routine 5
moving and leveling 7
resetting 5
shutdown 8

instrument status, troubleshooting 39

interconnect tube 2

K
KB basecalling run modules 78

L
laser

controlling. See manual control commands
leaks, troubleshooting 56

LED, instrument status 39

length of read, definition 76

leveling , after moving instrument 7

LOR definition 76

loss of resolution 53

low signal strength 52

lower polymer block, illustration of 2

Luer fitting, illustration of 2

M
maintenance tasks 3

computer 28
routine 5

manual control
accessing 26
filling capillary array 8
options, table 24

manual control commands 24

manually filling capillary array 8

matrix standard
fragment analysis 83

migration time, too fast or too slow 55

modules 60
fragment analysis 81, 82
KB basecalling 78
run module tables 84
run parameters 61
sequencing 76

mounting pin, illustration of 2

moving the instrument 7

N
"No candidate spectral files found" 43

O
O-ring, illustration of 2

oven, controlling. See manual control commands

overflow hole, illustration of 2
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P
password

case-sensitive 39
changing 39
expired or corrupt 39
troubleshooting 39

PDP motor cover, illustration of 2

peaks, troubleshooting 56

piston, illustration of 2

plate linking, relinking 47

plate record
creating multi-application 69
fill down special option 65

polymer
cleaning off 5
storing 16

polymer blocks
bubbles 22

polymer delivery pump (PDP)
illustration 2
water trap 13

polymer supply bottle cap with hole, illustration of 2

polymer supply bottle, illustration of 2

polymer supply tube, illustration of 2

power override
enabled 39
triggers 39
troubleshooting 39

priority scheduling 62

pump block, illustration of 2

pump chamber, illustration of 2

R
RA number 90

RA number. See return authorization number

red status light 38

removing bubbles 22

Replenish Polymer Wizard 17

reporting, damages 90

reservoirs
cleaning 10
positions on the autosampler 10

resetting the instrument 5

resolution
fragment analysis 81

resolution, loss 53

return authorization (RA) number 90

returning damaged items 90

returns 90

Roxio Easy CD, accessing 31

run
elevated baseline 52
elevated current 54
fast migration time 55
fluctuating current 54
high signal 51
loss of resolution 53
low signal 52
no current 54
no signal 51
parameter ranges 61
priority scheduling 62
slow migration time 55

run module 84
customizing 60
tables 84

run time
fragment analysis 81

Run validation tests 49

S
scheduling, run priority 62

sequencing
run modules 84
specifications 76

shut down 8

shutdown 10

signal too high 51

spatial calibration
persistently bad results 41
troubleshooting 41
unusual peaks 41

specifications
fragment analysis 81
sequencing 76

spectral calibration
deleting a 35
if a capillary fails 44
if all capillaries fail 45
no signal 42
override capillaries 44
troubleshooting 42

spectral calibration standard, types 77
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T
technical support, for computers with altered 

configuration 87

tests, validation 49

troubleshooting
failing capillaries 44
instrument startup 38, 39
instrument status 39
leaks 56
password 39
plate linking 47
power override 39
run performance 50
spatial calibration 41
spectral calibration 42
using validation tests 49
yellow status light, instrument 39

U
Update Cap Array Info wizard 20

W
warranty

damages, claims, returns 90
exceptions 88
for computers with altered configuration 87
limitations 88
period 87

warranty claims 88

warranty exceptions 88

warranty period, effective date 88

water seal, illustration of 2

water trap
filling 13
flushing and filling 13
illustration of 2

wizards
accessing and overview 11
Autosampler Calibration 23
Bubble Remove Wizard 22
Change Polymer Type Wizard 17
Install Array Wizard 19
Instrument Shutdown 10
Replenish Polymer Wizard 17
Update Cap Array Info 20

Y
yellow status light, instrument 39

Z
Z dye set, sequencing kit table 77
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